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Welcome to Logic

 

This guide is designed to get you up and running with Logic 
in the shortest possible time.

 

It does not cover all areas of the program. What you will find are descriptions of the 
most essential aspects of Logic’s interface, commands, and menus—the “tip of the 
iceberg,” if you will. In most cases, one method will be shown. As you become more 
familiar with Logic, you’ll discover that there are often several ways to achieve an end 
result.

The descriptions are laid out in a “what you see” fashion, and are generally paired with 
step-by-step instructions for accomplishing specific tasks. Follow these instructions to 
quickly learn how to handle MIDI and audio information via a series of examples.

It goes without saying that you will be introduced to a number of new terms and 
concepts. The first rule:  Don’t panic!

Just follow the steps, look at the screenshots (and Logic itself ), and take your time 
while trying things. The second rule:  You can’t break anything, so feel free to 
experiment. Do, however, pay attention to notes and warnings in the guide.

In general, methods that work in one window will work identically (or similarly) 
throughout the application. Once you have a handle on the basics covered in this 
guide, you’ll find that the more “advanced” functions are just as easy to master.

If you’d like to learn more about digital audio and the elements of a music project, read 
Appendix A, “Audio and MIDI Basics.” Appendix B provides information about Audio 
and MIDI in Mac OS X. Appendix C will help you to optimize your computer for music 
production.

Additional, more comprehensive information can be found in the other Logic manuals. 
Some come as printed guides, but the complete collection is included in electronic 
form in the Documentation folder of the Logic Install DVD. The most important 
electronic books are also accessible from the Logic Help menu.
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    Welcome to Logic

 

Conventions of This Manual

 

The following conventions are used in this manual:

 

Menu Functions

 

For functions that can be reached via hierarchical menus, the different menu levels are 
illustrated as follows:  Menu > Menu entry > Function.

 

Important Entries

 

Some text will be shown as follows:

 

Important:  

 

Information on function or parameter. 

These entries discuss a key concept or technical information that should, or must, be 
followed or taken into account. Please pay special attention to these entries.

 

Notes

 

Some sections provide additional information or tips that will assist your use of Logic. 
These are displayed as shown below:

 

Note:  

 

Information on function or parameter.

 

Key Commands

 

Many Logic functions can be activated or accessed with key commands—computer 
keyboard shortcuts. The key commands mentioned in this guide are based on the 
English Standard key command set. 

 

Tips

 

A number of shortcuts, alternative methods, or general working tips are included 
throughout the documentation. These may help your workflow, or provide additional 
information on other uses for functions. Tips are shown as below:

∏

 

Tip:  

 

Information on function or parameter.

 

Warnings

 

A few warning messages are included for functions that are destructive, and could 
result in irretrievable data loss, or could cause damage to your equipment. Warnings 
are displayed as follows:

Please pay special attention to these entries, as they can save you from making costly 
mistakes.

 

Warning:  

 

Information on function or parameter.
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Starting Your Project and 
Importing Media Files

 

The basic Logic file (or document) type is the project. 
A project can contain audio recordings, MIDI performances, 
and your personal working preferences. 

 

A project must be open before you can work in Logic.

 

To launch Logic, open and save a new project:
1

 

Double-click the Logic icon in the Applications folder. 

The Templates dialog appears. 

 

2

 

Choose the Empty Project item in the Templates dialog. If not visible, click the Explore 
folder icon in the Collection column. 
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The empty project will open, and you will see the New Tracks dialog. 

 

3

 

Ensure that the Audio button is highlighted. If not, click it.

 

4

 

For now, simply click the Create button at the lower-right corner of the New Tracks 
dialog. 

The main Logic window—the Arrange—is shown, with one audio track visible.

 

5

 

Choose File > Save As, which will open the Save As dialog.

 

6

 

Type in a new name, such as “test.” Choose the desired folder path (or create a new 
one).

 

7

 

Ensure that the Include Assets and “Copy external audio files to project folder” 
checkboxes are enabled. Click the disclosure triangle to see the Advanced Options, if 
not visible.

 

Note:  

 

The project assets may include audio files, video files, EXS instrument files, and 
more. Dependent on your choices in the advanced options, these files can be saved in 
the project folder. This simplifies archiving, and makes it easy to transport entire 
projects to other Logic-based studios (or computers).

 

8

 

Click the Save button at the lower-right corner.
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A Quick Note About Templates

 

When you first open Logic, it looks for a project file. If no suitable files are found, the 
Templates dialog automatically opens. You can also open it at any time by choosing 
File > New. 

The Templates dialog contains a number of “ready-to-wear” projects that have been 
customized for particular jobs; creating a printed score, working with film, creating a 
hip-hop track, and so on. Take a look at each of them, after you’ve read the guide.

You can use these as starting points for your own projects, or can customize these (or 
create completely new) templates. Once you have spent a little time with Logic, you’ll 
discover how you like to work, and how to set up and personalize Logic—to make it 
behave the way you like to work. For now, keep your customizations to a minimum.

 

Getting to Know the Arrange Window

 

After loading and saving your new project, and creating an audio track, you will see the 
following on screen:

Â

 

Arrange window:

 

  This is the main window of Logic. It can incorporate all working 
areas and editors.

Â

 

Main menu

 

 (not shown in image):  Used for global file and edit operations, and to 
access program-wide options, including screenset functions (see “Using Screensets” 
on page 72). The Window menu is used to open different editor, and other, windows.

Click this button to
display the Inspector.

Arrange window

Transport bar

Bar ruler

Click this button to 
hide the Toolbar.

Click these buttons to display 
the Lists or Media area.

 Inspector

Toolbar

Click these buttons to 
display one of the editors.

Local menu bar

Arrange channel strips

Arrange area

Track list

Vertical zoom control

Horizontal zoom 
control

Playhead

Tool menu
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Â

 

Toolbar:

 

  Toolbar buttons execute several major functions. The Media and Lists buttons 
open/close the Media and Lists areas (shown below the buttons, when open).

Â

 

Local menu bar:

 

  Provides access to window-specific functions.
Â

 

Tool menu:

 

  Provides access to tools, used for selection and editing tasks.
Â

 

Bar ruler:

 

  Horizontally displays Logic’s time axis—from left to right. It is also used for 
navigation, playback, and recording tasks.

Â

 

Track list:

 

  This is where you select, create, move, and delete tracks.
Â

 

Arrange area:

 

  This is the arrangement workspace. It can contain any number of MIDI 
or audio regions, aligned on horizontal track lanes (shown in the track list).

Â

 

Playhead:

 

  The playhead indicates the current project position, and moves from left 
to right as the project is playing. The playhead can also be used as a target for paste 
operations.

Â

 

Inspector:

 

  The Inspector is used to adjust various aspects of track or region playback. 
Channel strips—for the selected track, and its destination channel—are displayed at 
the bottom of the Inspector.

Â

 

Editor buttons:

 

  The Mixer, Sample Editor, Piano Roll, Score, and Hyper Editor buttons 
open or close the corresponding editor window above the Transport bar—the 
Arrange area is resized to accommodate the editor. 

Â

 

Transport bar:

 

  Used to control playback and recording operations. 
Â

 

Zoom controls:

 

  Drag the Zoom control sliders to change the horizontal and vertical 
magnification factor of the window contents. 

 

Creating Tracks

 

Logic works on the basis of tracks, much like a multi-track tape machine. You can see 
and access these tracks in the Arrange window track list.

If you followed the steps outlined above when opening Logic, the project will contain a 
single audio track, called Audio 1. There are two other track types that can be used to 
create arrangements; instrument and external MIDI tracks.

 

To create a few new tracks:
1

 

Click the + button directly above the track list.

 

2

 

In the New Tracks dialog, click the Audio button (if not already active).

 

3

 

Highlight the number “1” in the numeric field at the top of the dialog, and type in “3”. 
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Check out the Format, Input, and other options available while the dialog is open.

4 Click the Create button. 

The dialog closes, and three new audio tracks (“Audio 2,” “Audio 3,” and “Audio 4”) are 
created in the Arrange track list. 

5 Repeat the steps above, but click the Software Instrument button, and type “4” in the 
numeric field of the New Tracks dialog to create four new software instrument tracks 
(“Inst 1,” “Inst 2,” and so on).

Important:  Now would be a great time to save your project. Presuming you followed 
the steps when you first launched Logic, and have already “saved as,” you can choose 
File > Save (or use the default Save key command:  Command-S).

You can also follow the steps above to create External MIDI tracks, which are used for 
the recording and playback of external MIDI synthesizers. Use of external MIDI tracks 
(and hardware) is discussed in the Logic user manual.

You should be looking at something like this:

The last of the new tracks (Inst 4) is highlighted in the track list, and the Library window 
is shown to the right of the Arrange window.

You can use the Library to insert an instrument (plus effects) into a channel strip:
1 Click any of the categories shown in the Library:  01 Pianos, 02 Electric Pianos, 03 

Clavinets, and so on.

2 Click any of the sub-categories shown in the second column of the Library (if 
applicable). A third column is shown.

Library



12 Chapter 1    Starting Your Project and Importing Media Files

3 Click on any of the entries (known as settings) shown in the second or third column. 
Play your keyboard after loading each setting.

You will see that the left Arrange channel strip automatically updates—usually with at 
least two or more (blue) Insert slots, plus the Instrument slot—being activated. These 
are known as channel strip settings, rather than individual instrument settings. Not 
only is an instrument plug-in loaded, but also all effect plug-ins used by the channel 
strip. Even better, the setting of each plug-in (instrument and effect) is automatically 
loaded. You will soon be making a recording with this instrument, but your project 
needs a “bed.”

Channel strip settings

 Instrument slot

 Insert slot
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Adding Media Files
When you record or add MIDI or audio files (media, in other words) to the Arrange 
window, narrow rectangles called regions appear—horizontally aligned on track lanes. 
An audio region represents an underlying audio file (or a portion of it). This can be an 
existing or new audio recording. A MIDI region represents an individual recording, or 
take of MIDI data. Again, this can be an existing or new recording.

Â You can only record, import, and play back MIDI regions on software instrument or 
external MIDI tracks. MIDI regions actually contain MIDI events.

Â You can only record, import, and play back audio regions on audio tracks. Audio 
regions are simply placeholders or pointers to underlying audio files.

Audio region MIDI region
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To add an audio region by importing an audio Apple Loop to an audio track:
1 In the Media area to the right of the Arrange window, click the Loops tab. 

The Loop Browser replaces the Library.

2 Click the Column View button towards the top right of the Loop Browser.

3 Click All in the left column, at the top of the Loops Browser. 

A list of sub-categories appears in the center column.

4 Click All Drums in the center column, and click All Drums in the right column, when it 
appears. 

A list of Apple Loops is shown at the bottom of the Loop Browser.

5 Click on any loop name in the list (with a blue icon, and preferably with “16” shown in 
the Beats column), and it will immediately begin playback. Click the name a second 
time to stop playback.

6 Once you’ve found a loop you’d like to use, grab it, and drag it to the very beginning of 
Bar 1 (shown in the Bar ruler)—on the track called “Audio 1” in the Arrange area.

7 Release the mouse button, and you’ve successfully imported your first audio region 
into Logic.

Column View button
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To add other audio file types with the Browser:
1 Click the Browser tab at the top of the Media area. 

The Browser replaces the Loop Browser.

2 Locate the desired file in the Browser.

Navigation in the Browser is much like using the Mac OS X Finder. The method of 
navigation is the same for all file types. The bookmark buttons, Path menu, and Back 
and Forward buttons aid navigation. The search functions make it easy to find any file. 
These work much like Spotlight.

3 Once you have found the desired file, you can drag it directly to any position in the 
Arrange area. 

Back and Forward
buttons

Play button

Search field

Search filters

File list

Path menu Bookmark buttons View buttons
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You can switch the Browser between two views:  List and Browser view. 

Â List view displays folders and their contents in a list. You enter a folder by double-
clicking it. 

Â Browser view exposes the contents of a folder in new frames to the right of the 
selected folder. You only need to click once on a folder to enter it. 

To switch between List and Browser view:
m Click on the Browser button to access the Browser view. Click on the List button to 

access List view.

To add a MIDI region by importing a Software Instrument Apple Loop to an 
instrument track:

1 Click the Loops tab in the Media area, and click Bass in the center column (if not visible, 
click the All entry in the left column).

2 Choose Bass in the right column. 

A list of Apple Loops is shown at the bottom of the Loops tab.

3 Click on any of the loop names with a green icon (ideally, also showing 16 in the Beats 
column). It will automatically start playing.

4 Once you’ve found a loop you like, drag it to bar 1 of the “Inst 1” track.

Congratulations! You have imported a MIDI region to the track. 

Browser viewList view

Browser buttonList button



Chapter 1    Starting Your Project and Importing Media Files 17

You can consider the MIDI region a container for MIDI information. This can include—
either individually or in combination—note events, controllers, program changes, or 
even SysEx for your MIDI tone generators. All MIDI event types are discussed in the 
Logic user manual.

Important:  The Arrange window only deals with regions—it does not allow you to edit 
the MIDI events or audio information in regions! If you need to make precise changes 
to the region content, you can do so in the editor windows. See “Editing MIDI Events” 
on page 47 and “Editing Audio Files” on page 59.

These procedures (and the track creation method covered earlier) can be repeated 
numerous times, allowing you to build huge arrangements—with hundreds of tracks, 
and thousands of regions. You may freely drag and drop regions to any position in the 
project, but remember that audio regions only play on audio tracks. MIDI regions only 
play on software instrument or external MIDI tracks.

Apple Loop Types
As you’ve found out, there are two types of Apple Loops. 
Â Apple Loop audio files (blue icon) contain audio data and identification information; 

time and date, category, mood, key and tempo, amongst others. They also contain 
transient markers, which break them down into small time slices. The advantage of 
Apple Loop audio files is their ability to automatically match the tempo and key of a 
Logic project. You can only add these file types to audio tracks.

Â (SIAL) Software Instrument Apple Loop files (green icon) also contain MIDI note 
information—that triggers a musical phrase or riff. The motif will be played, as is, 
when these types of Apple Loops are added to an audio track (in other words, they 
behave just like the blue Apple Loop audio files). When added to an instrument track, 
however, the MIDI note information can be edited, as you would with any MIDI 
region. SIALs also contain instrument and effect setting information. When these 
loop types are added to a blank instrument track (one with an empty channel strip), 
a software instrument is automatically inserted into the Instrument slot.

Automatic Track Creation From Media Area Windows
The Loop Browser and Browser have a trick up their sleeve that can accelerate your 
workflow.

To create a track and import a loop in one step:
m Directly drag an Apple Loop (of either type) from the Loop Browser into:

Â An empty Arrange window (obviously, not applicable at this point).
Â To the blank space below existing tracks.
A new audio or instrument track will be created, and the Apple Loop region will appear 
in the Arrange area, at the dropped position.
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To create a track and import an audio file in one step, either:
m Double-click on an audio file name in the Browser. 

m Drag an audio file from the Finder into the Arrange window.

A new audio track is created at the bottom of the track list. An audio region is created 
at the playhead position on the new track.

Navigating Your Project
Navigation—and playback—of Logic projects can be achieved in several ways:  with 
the Transport, in the Bar ruler, or by using markers or locators. This section outlines 
some basic techniques that will help you to get around your projects. Further, 
advanced navigation topics are covered in the Logic user manual.

Using the Transport Bar
The Transport bar spans the entire lower edge of the Arrange window. You can use it to 
move through your project and to start/stop recordings—using Play, Rewind, Pause, 
Record, and other buttons. The Transport bar also incorporates features that simplify 
tasks you will perform in Logic, such as recording over a continuously repeated section 
of your project, or listening to a part in isolation.

The Transport bar consists of the following areas:
Â Transport buttons:  Used to navigate your project.
Â Display area:  Provides information that helps with project navigation.
Â Mode buttons:  Enable advanced recording and playback functions.

Note:  The Master Level slider—which sets the master output volume level for the 
project—may be visible at the right-hand end of the Transport, if there’s enough 
horizontal screen space. 

To start and stop playback:
1 Simply click the Play button on the Transport (or use the default Play key command:  

Enter—on the numeric keypad of your computer keyboard), to play the project. 

2 Press the Stop button on the Transport to stop the project (or use the default Stop key 
command:  “0” on the numeric keypad).

3 To return to the beginning of the project, click the Stop button (or “0” key) again.

Note:  Alternatively, you can use the Space bar to toggle Start and Stop operations.

Transport buttons Display area Mode buttons

Click to stop Click to play
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Using the Bar Ruler
The Bar ruler displays the project timeline, from left to right. It is broken down into bar 
and beat divisions, indicated by vertical lines and numbers. You can also view actual 
time values by clicking on the note icon at the right-hand end of the Bar ruler, and 
choosing a suitable option from the pop-up menu.

The Bar ruler and Transport are closely tied to each other, with several functions 
accessible in both. These include the play and stop commands, plus activation of Cycle 
mode, and setting the cycle length. The Bar ruler also changes color when the 
Transport Record, Solo, or Sync buttons are active—providing clear visual feedback on 
the current mode. Keep an eye on the different fields in the Transport bar while trying 
out the following Bar ruler techniques. If you click-drag vertically on the corresponding 
numerical values in the Transport, your change will be reflected in the Bar ruler.

Setting the Playhead Position and Controlling Playback
The playhead indicates the current project position. You can directly interact with the 
playhead by dragging it in the Arrange area, or in the Bar ruler. The latter option is safer 
because there’s no chance that you’ll accidentally alter any regions.

To move the playhead to any position:
m Click at any position in the lower half of the Bar ruler. 

The playhead will instantly move to the clicked position. You can also click-drag the 
playhead, if preferred.

To start or stop playback at any project position:
m Double-click at any position in the lower half of the Bar ruler. 

The playhead will instantly move to the clicked position, and playback will begin from 
this point. If Logic is already in play (or record) mode, a double-click in the Bar ruler will 
stop playback at the clicked position.

Playhead



20 Chapter 1    Starting Your Project and Importing Media Files

Setting and Using the Cycle
The upper portion of the Bar ruler contains the cycle stripe—shaded gray when 
inactive, or green when active. The cycle acts as a set of playback markers (or locators). 
When Logic is in Cycle mode, the playhead will continuously loop between the start 
and end points of the cycle. The cycle can be placed anywhere in your project, and can 
be of any length. Beyond playback duties, the cycle can also be used to define a 
section of your project for editing operations. Details can be found in the Logic user 
manual.

To activate or deactivate the cycle, do one of the following:
m Click the shaded gray cycle area in the top half of the Bar ruler (the cycle is green when 

active). 

A second click deactivates the cycle (returns to gray shading).

m Click the Cycle button on the Transport (green when active). 

To move the cycle:
m Move the mouse over the middle of the cycle in the Bar ruler (the cursor will change to 

a hand icon), and drag it to the right or left.

Right locatorLeft locator

Click here to activate the cycle.
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To change the cycle length:
m Move the mouse over the right or left-hand end of the cycle in the Bar ruler (the cursor 

will change to a resize icon), and drag it to the right or left.

Keep an eye on the locator display in the Transport bar while changing the cycle length.

Undoing Operations
Before getting too far into the “hands-on” portion of this guide, you should know about 
the Logic safety net—the Undo function. It’s inevitable that you will make an 
occasional error, perform an operation that doesn’t deliver the results you were after, or 
simply change your mind, when using Logic.

Most operations in Logic can be reversed, but not all! As you work with the application, 
you will discover what can, and cannot, be undone with the Undo functions. For 
operations that can’t be undone in this way—such as region playback parameters 
(which you’ll learn about in a little while)—you will generally need to change a value 
back to its former (or the default) value.

To undo the last operation, command, or function:
m Choose Edit > Undo [the name of operation, command, or function]. The Undo command 

can also be executed by pressing Command-Z.

If you’ve made a couple of changes, and decide that you want to revert to an earlier 
state, Logic offers the Undo History. This is a catalogue, if you will, of all editing 
operations. It is saved with the project.

Right locator

Left locator

Playhead Position display
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To reverse a number of operations, commands, or functions:
1 Choose Edit > Undo History (or press Option-Z) to open the Undo History window. 

The Undo History window shows a list of all operations. All operations are listed from 
the bottom up—with the most recent operation shown at the foot of the list.

2 Click on any step to reverse all operations, starting with the most recent (bottom of the 
list), and working backwards (up the list).

To undo or redo an isolated step:
m Command-click on the desired step.

Selecting Tracks and Regions
Track or region selection is essential for all recording, editing, and arranging tasks. You 
can’t move a region unless you’ve selected it. Similarly, you can’t adjust track channel 
strip functions (such as volume or pan changes) unless the track name is selected in 
the track list.

Selecting Tracks
You’ve probably noticed that one of the track names is always highlighted in the track 
list. This indicates that it is the selected track. As you’ve discovered, you can freely drag 
regions onto tracks, regardless of whether or not they are selected. You can not, 
however, record to a track unless it is first selected, and armed for recording. More on 
this shortly. 

To select tracks for editing:
1 Click the Inst 1 track (the fifth track in the list, which will now have a different name), 

and see how the Arrange channel strip updates, to reflect the current track selection. 

Note:  The region on the track is also highlighted, indicating that it is selected. By 
default, when you select a track, all regions aligned on the track lane are automatically 
selected.

2 Click the Piano Roll button at the bottom of the Arrange area to view, and edit, the 
contents of the selected region.
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Selecting Regions
Regions can be freely selected on any track, at any time—regardless of whether or not 
the parent track is selected.

To select a region:
m Click directly on the audio region on the Audio 1 track. 

Selected regions are easily identified by a black name bar that spans the top of the 
region.

To select several regions, do one of the following:
m Click-hold on the Arrange area background, and drag across several regions. 

As you do so, you’ll see a rubber band selection area. Each region is automatically 
highlighted (selected) as it is touched by the rubber band. 

m Shift-click on the desired regions. Use this method when the regions you want to move 
are not aligned side-by-side, or laid out above/below each other.

The multiple selection methods outlined above (rubber banding or shift-clicking) can 
be used for any region editing operation—when you want to alter several regions in 
the same way.
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2 Recording

Both audio and MIDI information can be recorded directly in 
the Arrange area.

The procedure is more or less the same for any recordings you make:  select (and arm) 
a track, start recording, perform, stop recording. Recordings can even automatically 
start and end at predefined positions (punch recording), can be comp-ed, offset, and 
much more. See the Logic user manual for full details.

Preparing to Record Audio
Before any audio can be recorded, you must first set a recording path and file name—a 
location on your computer’s hard disk, and a name for your recorded audio files. 

If you followed the steps when first launching Logic, use of the Save As dialog, and 
activation of the Assets checkboxes, did two things:  it provided a recording file path—
the project folder—and ensured that the track name would be used for each new 
audio recording. 

There are dozens of preferences and settings that can affect the way Logic handles 
recordings. These are accessed by clicking the Preferences or Settings buttons on the 
Arrange Toolbar. As you spend more time with Logic, you will find particular methods 
that best suit your working style. In many cases, you can alter a preference or setting 
that will automatically default to a desired view, change the appearance of windows, or 
result in a particular behavior when editing or recording. The outcome of making such 
changes is a faster, smoother, and simpler workflow.

The four main things to check, and set, before making any recordings (MIDI or audio) in 
your project are covered below. These settings are saved with the project.
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To set the project sample rate:
m Choose File > Project Settings > Audio (or use the Open Audio Project Settings key 

command), and choose the desired sample rate in the Sample Rate menu.

To set the basic project tempo, do one of the following:
m Click-hold the Transport tempo value and drag up or down. 

m Double-click on the Tempo field in the Transport, and type in a new value. Press Return/
Enter, or click outside the Tempo field to exit the dialog.

The project tempo is primarily of interest for MIDI recording, but it also impacts on the 
metronome, which generates the click sound heard during the count-in.

The Importance of the Sample Rate
Digital audio needs to play at its original sample rate, or be converted to a different 
one, before playback at another sample rate. To explain; when a file which was 
created by sampling 96,000 times per second (96 kHz sampling rate), is played back 
in an application that is set to a sample rate of 48,000 samples per second, it will play 
back slowly (half the speed).

Commonly used sample rates include 44.1 kHz for CD quality audio and 48 kHz for 
audio files used in digital video productions. 
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To alter the metronome settings:
1 Click the Settings button in the Arrange Toolbar, and choose Metronome from the 

menu.

In general, you won’t need to alter the Metronome settings, but some people prefer to 
only hear the click during the count-in.

2 Do one of the following

Â Check the “Only during count-in” checkbox to limit the click to the count-in.
Â Uncheck the “Click while recording” checkbox to disable the metronome while 

recording.

To set the count-in time:
1 Click the Settings button in the Arrange Toolbar, and choose Recording from the menu.

2 In the Recording Project Settings window, click the Count-in menu, and choose the 
desired number of bars or beats. 

A series of clicks—the count-in (of the set length)—is heard before you begin 
recording, so you’ll know when to start your performance.
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Recording Audio Regions
The following assumes you have correctly connected a microphone, guitar, or some 
other audio source that you can record. For more information on doing this, see the 
Logic user manual.

To make a standard audio recording:
1 Turn off Cycle mode, if enabled.

2 Click the Record Enable button on the Audio 2 track (or another region-free audio 
track, if you added a few Apple Loops or other files earlier). This arms the track. 

If you sing into your microphone or play your guitar, you should hear it, and see the 
level meters of the Arrange channel strip moving.

∏ Tip:  You can activate the Input Monitoring button at any time on audio tracks (and can 
generally leave it enabled). This allows you to hear incoming audio, even when the 
track is not armed, which is useful for setting audio levels or practicing parts before 
committing to recording.

3 Click the Record button on the Transport (or use the Record key command, 
default:  *—on the numeric keypad) to start recording on the selected track—following 
a count-in.

4 Play or sing.

5 When you are finished, click Stop on the Transport (or press the 0 key on the numeric 
keypad, or the Space bar) to end recording.

This recording will appear as an audio region (on the Audio 2 track) in the Arrange area.

Click to enable input monitoring
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Recording Takes
Logic provides advanced take management facilities. A take is a part (a guitar solo, for 
example) that is performed and recorded multiple times. You can record several 
consecutive versions of a solo, and pick the best take, for example. Takes are usually 
created by recording in Cycle mode, but can also be created by simply recording over 
existing regions. 

Takes also form the basis for comping tasks, where the best performances (from several 
takes) are compiled into a single “super take.” This comp(ilation) will be used as the 
final version of your take. Full details on comping are found in the Recording chapter of 
the Logic user manual.

The preparation for take recording is identical to that for audio recording. No special 
setup is required, so you can start take recording as you would for any audio recording. 

The first take appears as an audio region, as per usual. Once a recording takes place 
over an existing region (the second pass of a cycle recording ends, and the third cycle 
begins, or you manually stop recording after the first bar, for example), a take folder is 
created. 

To open a take folder, do one of the following
m Click the disclosure triangle on the upper left corner of a take folder. 

m Double-click the take folder.

The contents of the take folder will be displayed on temporary Arrange track sub 
lanes—below the take folder itself. The most recently completed (or nearly completed) 
take is selected by default. The selected take will be heard during playback.

Take folder

The selected take will be 
heard during playback.
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To select different takes when viewing an open take folder:
m Click on the corresponding take header.

All take editing operations are covered in the Recording chapter of the Logic user 
manual.

Recording an Instrument Part
Earlier on, you used the Library to load an instrument into the Inst 4 track, and chose a 
setting. 

To record an instrument region:
1 Click the Inst 4 track name in the track list. The name shown in the track list is that of 

the active channel strip setting. 

Â Selecting an instrument track automatically prepares it for recording—but you must 
send a live MIDI event (as examples:  play a note on your keyboard, move the 
modulation wheel, press the sustain pedal) to switch software instruments into live 
mode. Once in live mode (or pressing the record button), the software instrument is 
automatically armed for recording.

Â Selecting an external MIDI track automatically arms it for recording.

2 Feel free to choose another sound (setting), by activating the Library in the Media area.

3 Click the Record button on the Transport, or press the * key on the numeric keypad.

You will hear a one bar count-in, and a constant metronome click. If not, revisit “To alter 
the metronome settings:” on page 27. Most people find it easier to make a musical 
instrument recording to a click.

4 Play your keyboard.

5 Click the Stop button on the Transport once you’re done.

A (selected) MIDI region appears on the instrument track lane.

If you’re happy with your recording, click the Play button (Enter on the numeric keypad 
or the Space bar) to hear it, and the other regions, play back.

If your part is close, but you messed up a note or two, you can edit them—rather than 
redoing the whole thing. This is covered in “Editing and Creating Events” on page 50. 

If the timing of your recording isn’t as you’d like it to be, you can quantize the region.
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To correct the timing of your recording:
m Click on the Quantization value in the Region Parameter box, and try out a few 

quantization values. If you find one that nicely tightens things up—keep it!

If you really blew it, re-record the part. Press the Backspace key (or choose the Eraser 
tool, and click on the region—see Tools section in next chapter) to delete the region, 
then repeat steps 1 and 2.
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3 Creating Your Arrangement

The large gray space to the right of the track list is the 
Arrange area. 

This is where recorded or imported audio or MIDI regions (such as the Apple Loops 
you’ve added, and your recordings) are arranged into a song structure. You can freely 
drag and drop your regions from position to position, loop, copy, cut, and resize them.

Just above the Bar ruler—to the top right of the Arrange area—you’ll see the Drag and 
Snap menus. These affect how regions behave when edited or moved. More 
information can be found in the Logic user manual.

Arrange area

Bar ruler
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Choosing Tools
Key to selecting, and altering, audio and MIDI regions in the Arrange (and events or 
data in other editing windows) are the tools. The Tool menus contain a Pointer, Pencil, 
Eraser, Scissor, and Glue tools (amongst others) that allow you to select, create, and edit 
regions (or events). 

The Tool menus are context-sensitive. This means that different tools are available in 
different windows. As an example, there is no Crossfade tool in the Score Editor 
window, as it doesn’t handle audio information. There is, however, a Voice Separation 
tool in the Score Editor, which would be of no use in the Arrange area, for example.

You can change the currently active tool by clicking on the appropriate icon in the 
menu. The mouse pointer will adopt the shape of the selected tool, making it easy to 
recognize.

You can also select a second tool—for use via a Command-click. This second tool is 
available when the Command key is pressed while editing. You can also assign the 
right mouse button (if using a multi-button mouse) to a third tool, allowing the use of 
three assignable tools—in each window:
Â Left-click tool:  Choose this from the left Tool menu.
Â Command-click tool:  Choose this from the right (or center, see below) Tool menu.
Â Right-click tool:  Choose this from the right Tool menu. 

Note:  The third Tool menu will only appear when the Logic > Preferences > Global > 
Editing > Right Mouse Button preference is set to:  Is Assignable to a Tool. By default, 
this preference is set to:  Opens Shortcut Menu. Leave it as it is, for now.

 Left-click Tool menu Right-click Tool menu

Command-click Tool menu
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∏ Tip:  You can quickly access tools by pressing the Esc key on your computer keyboard. 
The Tool menu will float at the current mouse pointer position. When this floating 
menu appears, simply click the appropriate tool (or press the corresponding keyboard 
key, shown to the right of the tool names) to make it active. 

 

Effective Range of the Tools
Â Tools are only effective in the working area of the editing window that they were 

selected in. As the Arrange window can contain other windows, you could assign (up 
to) three tools for the Arrange area, three tools for the Piano Roll Editor, and three 
tools for the List Editor, for example. As you move the mouse pointer between these 
areas, the active tool (and cursor) changes.

Â A tool basically affects the region (or event in one of the event editing windows) you 
click on. If multiple regions (or events) are selected, the tool will operate on all of 
them.

About the Tools
There are many additional tools to those outlined below—found in specific editing 
windows. The following are the four primary tools used during project construction 
and editing. Information on the Solo and Mute tools follows. Window-specific tools are 
discussed in the respective chapters of the Logic user manual.

Pointer
The Pointer is the default tool. The mouse cursor also takes on this shape outside the 
working area, when you are selecting from a menu or entering a value. Within the 
working (active) area, the Pointer is used for:
Â Selecting (by clicking on regions/events).
Â Moving (by click-holding and dragging).
Â Copying (by holding down the Option key and dragging). 
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Â Editing lengths (by click-holding the bottom right or left corner of a region or event, 
and dragging horizontally). 

Â Click-holding and dragging—horizontally and/or vertically—anywhere on the 
window’s background allows you to rubber band select multiple regions (or events).

Pencil
The Pencil is used to add new regions or events. You can also select, drag, and alter the 
length of regions/events with this tool.

Eraser
The Eraser deletes regions/events. This is done by clicking on them once. When you 
click on a selected region or event, all other selected regions/events are also deleted.

Scissors
The Scissors are used to divide regions/events—before copying or moving individual 
sections, for example.

Muting and Soloing Tracks and Regions
Trying out different arrangements, editing, and tracking down that “weird” sound in 
your projects can be made easier with the Mute and Solo functions. You have the 
choice of muting or soloing a track (and therefore all regions on the track), or one (or 
more) selected regions.

Muting Regions
Often, when arranging, you’ll want to test musical ideas by muting certain regions. 

To mute or unmute individual regions:
1 Select the Mute tool.

 

2 Click on the desired regions. 

A second click with the Mute tool will unmute it.

 

Muted regions are indicated by a dot that precedes the region name.

Mute tool
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To mute several regions with the Mute tool:
1 Shift-click, or rubber band select the regions that you want to mute (this selection can 

be made when the Mute or Pointer tool is active).

2 Click on any of the selected regions with the Mute tool.

∏ Tip:  You can also mute one or more selected regions by right-clicking in the Arrange 
area. This opens the shortcut menu, where Mute and many other functions are 
available. Simply choose Mute in the menu to mute the selected regions. Note the 
default key commands (such as M, for Mute) that are shown beside each function in 
the shortcut menu. Try muting a region or two with all possible methods.

Soloing Regions
Soloing allows you to hear one or more selected regions in isolation, making it easier to 
identify particular elements that may need to be edited.

To solo a region with the Solo tool:
1 Select the Solo tool.

2 Click-hold on the desired region with the Solo tool. 

 

The region (outlined in yellow) will be heard in isolation from the click point, until you 
release the mouse button, which will stop solo playback. 

To solo several regions with the Solo tool:
1 Rubber band or Shift-select the desired regions.

2 Click-hold on any of the selected regions with the Solo tool. 

Solo tool
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Muting Tracks
You can click on a track’s Mute button to stop the track (and therefore all regions on 
the track lane) from playing. The button turns blue when active.

To mute multiple tracks:
m Click-hold the Mute button of one track, and drag the mouse up or down. 

The Mute buttons of all swiped tracks will switch to the same state. 

Soloing Tracks
Both MIDI and audio tracks offer Solo buttons. Soloing a track isolates it while 
playing—and mutes all other tracks. The button turns yellow when active.

To quickly solo multiple tracks:
m Click-hold the Solo button of one track, and drag the mouse up or down (over the Solo 

buttons of other tracks). 

The Solo buttons of all swiped tracks will switch to the same state. 

Editing Regions
The following region editing operations cover the basics needed to create an 
arrangement. Logic also features a number of advanced functions that allow you to 
move, cut, and replicate entire sections (such as a verse or chorus) of your project. 
More information can be found in the Logic user manual.

Important:  Take care that only one region is selected when resizing, cutting, and so 
on—if you intend to alter this region alone. If multiple regions are highlighted, they will 
all be equally changed in length, or cut at the same position.
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Moving Regions
Key to creating any arrangement is the ability to move song segments (regions) to 
where they are needed.

To move a region:
m Select the region, and drag it to a new position.

To move several selected regions:
m Click-hold any of the selected regions, and drag (all regions) to a new position.

Dragged regions automatically “snap” to increments defined by the Snap menu setting. 
The Drag menu setting can also impact on behavior, when you drag regions to a 
position that overlaps other regions.

Changing the Length of Regions
You can reduce or extend the length of any region by dragging the start or end point 
of the region, thus determining what part of the source (audio file or MIDI events) is 
played back in your project. 

Important:  The information in regions is never deleted when they are reduced in 
length; playback simply starts at the beginning, and stops at the end of the region.

To resize a region:
1 Select the Pointer or Pencil tool, then place the cursor over the lower left or right hand 

corner of a region. 

The cursor changes to a Resize pointer.

2 Click the corner and drag to the left or right. 

An audio region can not be longer than the underlying audio file.

∏ Tip:  When performing operations that require precision, such as length changes or 
cuts, it can be helpful to get a “closer look.” Click-drag either the horizontal and/or 
vertical zoom sliders at the lower right of the Arrange area to increase or decrease the 
magnification. You can also rubber band select the desired area with the Zoom tool.
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Dividing Regions
You can slice any region into several parts, thus creating several individual regions. This 
allows you to move, copy, delete, or individually process each region. This is particularly 
handy when you want to use portions of a drum loop in different locations (as drum 
fills), for example.

To divide a region:
1 Select the Scissors tool, then place the cursor over the desired region. 

2 Click-hold, and drag to the left or right, while keeping an eye on the help tag. 

When the desired cut position is shown, release the mouse button, and the region will 
be divided into two regions. This does not affect the underlying audio file.

Cutting Regions
Regions can be removed from one section of your arrangement, and used in another. 
This is done by dragging them, as discussed above, or with the Cut and Paste 
commands.

To cut a region:
m Select the Pointer tool, and click on the desired region, then choose Edit > Cut (default 

key command:  Command-X). 

The region is temporarily stored in the Clipboard, ready for pasting (see “To paste a cut 
or copied region from the Clipboard:” below).

Use the rubber band or Shift-click options to select multiple regions for cutting.

∏ Tip:  The (right-click) shortcut menu also offers the Cut command (and Copy/Paste).
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Copying Regions
Regions can be replicated, allowing their use at other points in your project. An 
alternative to copying are the looping options, and the creation of alias MIDI regions, or 
clone audio regions. The looping options are discussed shortly. Details on alias and 
clone regions can be found in the Logic user manual.

To copy a region, do one of the following:
m Select the Pointer tool, and click on the desired region, then choose Edit > Copy 

(default key command:  Command-C). 

The region is temporarily stored in the Clipboard, ready for pasting (see below).

m Select the Pointer tool, and Option-drag the desired region to the left or right, while 
keeping an eye on the help tag. 

When the desired position is shown in the help tag, release the mouse button, and a 
copy of the region will be created at this position.

Use the rubber band or Shift-click options to select multiple regions, then Option-drag 
any of the selected regions to copy them all (or use the Edit > Copy command).

To paste a cut or copied region from the Clipboard:
1 Click at the desired paste (target) position in the lower part of the Bar ruler. 

The playhead will move to the clicked position.

2 Choose the target track lane by clicking on a track name (skip this step if the copied 
region is already on the selected track lane).

3 Choose Edit > Paste (or use the default key command:  Command-V) to paste the 
Clipboard contents (the copied region) at the playhead position—on the target track 
lane.

∏ Tip:  The (right-click) shortcut menu also offers the Paste command. You must ensure 
that no regions are selected in the Arrange before right-clicking, or the Paste command 
will not be available.
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Deleting Regions
You can remove regions from your project by using any of the methods outlined 
below.

To delete a region, do one of the following:
m Select the Eraser tool, and click on the desired region. 

m Use any of the selection methods discussed earlier (for one, or multiple regions), and 
either:

Â Click on one of the selected regions with the Eraser tool. 
Â Press the Backspace or Delete key. 
Â Right-click, and choose Delete from the shortcut menu.
All selected regions will be deleted.

Important:  These methods will actually remove MIDI regions (and the events they 
contain) from the project. Audio regions (and their underlying audio files), on the other 
hand, are simply removed from the arrangement, but not the project—they remain in 
the Audio Bin, and can easily be dragged back into the arrangement.

Eraser tool
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Looping Regions
Regions can be continuously played back, by creating a number of loop repeats. These 
look like ghost versions of the original region, as that is essentially what they are—
reflections of the source region.

As mentioned earlier, you can reduce or extend the length of any region by dragging 
the start or end point of the region (lower right or left corner). This has a direct impact 
on the length of the region, obviously, and also affects the length of all loops.

To loop a region, do one of the following:
1 Select either the Pointer or Pencil tool, and place the cursor over the upper right corner 

of the desired region. Try this with the audio Apple Loop on the Audio 1 track. 

The cursor will change to the Loop tool.

 

2 Click-hold, and drag to the right, while keeping an eye on the help tag. 

 

When the desired number of loop repeats have been created, release the mouse button. 
When you start playback, the region will repeat until the end of the last loop is reached.

To remove one or more loops:
m Click-hold on the top right edge of the last loop with the Pointer tool, and drag to the 

left. 

To remove all loops:
m Click-hold on the top-right edge of the original region with either the Pencil or Pointer 

tool.

The help tag will display “Loop off,” and all loop ghost regions will disappear.



44 Chapter 3    Creating Your Arrangement

Using the Inspector
The Inspector, to the left of the Arrange window, is divided into three main areas. From 
top to bottom:  the Region Parameter box, the Track Parameter box, and the Arrange 
channel strips.

∏ Tip:  Double-clicking on numerical values in (almost all) Parameter boxes, editors, on 
the Transport Bar, in plug-in windows, and so on, allows you to directly type in a 
value—using your computer keyboard, followed by pressing the Return/Enter key. This 
method can greatly accelerate your workflow. Give it a try while reading the following 
section.

Region Parameters
This parameter box is directly related to the regions shown in the Arrange area. When 
either a MIDI or audio region is selected—by clicking once on it with the Pointer—the 
Region Parameter box updates, to show the parameters assigned to that particular 
region. Each region in the Arrange area can have unique parameter settings, allowing 
independent transposition, quantization, and more. The parameters available for MIDI 
and audio regions are different. 

To view or hide the Region Parameter box:
m Click the disclosure triangle to the left of the region name shown at the top of the 

Inspector.

Track Parameter box

Region Parameter box

Arrange channel strips
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To change a parameter value:
m Simply click-hold to the extreme right of the Region Parameter box—alongside the 

desired parameter name (Quantize, for example). 

Â This will open a menu for some parameters. For others, the mouse pointer acts as a 
slider. 

Â Drag the mouse on the vertical axis (up and down) to change the value of these 
parameters. 

Please give this a try for each parameter (on both an audio and MIDI region)—to 
familiarize yourself with the methods used to interact with each of them.

Important:  It should be noted that the region parameters are real time playback 
processes, meaning that changing these parameter values—Quantize, Transpose, and so 
on—can occur while Logic is running. These processes don’t actually alter the events in 
regions, they merely change the way that the events are played back. 

To undo any parameter changes:
m Simply select the region that you want to “reset,” and change the parameters back to 

their former (or default) settings, using the techniques described above.

The Track Parameters
These parameters are linked to the track list. They vary in accordance with the type of 
track selected—audio, (software) instrument, external MIDI—and affect all regions on 
the track lane. The track type is determined by the channel it is assigned (routed) to. 
The track parameters simply mirror the parameters of the corresponding channel strip. 
The Track Parameter box updates each time a new track is selected in the track list. 

To view or hide the Track Parameter box:
m Click the disclosure triangle to the left of the channel name shown in the Inspector 

(below the Region Parameter box).

Using the Track/Channel Parameters
This is pretty much the same as interacting with the region parameters, as discussed on 
the previous pages.

As mentioned, the Track/Channel parameters affect all regions on the track lane (or 
lanes—multiple tracks can be routed to the same channel strip). This is of particular 
interest for MIDI regions on software instrument or external MIDI channels.

Choose an Inst track in the track list, and take a look at both the Region and Track/
Channel Parameter boxes (click the disclosure triangle if either is hidden). You will see a 
number of duplicate parameters, such as:  Transposition, Velocity, and Delay. 
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Use the Track/Channel Transposition parameter when you want to transpose all regions 
on a track (or for a particular channel strip), rather than selecting and transposing each 
region (with the Transposition parameter in the Region Parameter box). 

∏ Tip:  If you want to transpose most regions on a track, use the Track/Channel parameter, 
and then individually use the Region Transposition parameter on the few regions that 
you don’t want to transpose. Work smart, not hard!

The Arrange Channel Strips
At the lower left of the Arrange window, two mixer channel strips are displayed.
Â The left channel strip corresponds to the selected track in the track list. In other 

words, this is the channel that the track is routed to. Regions on the track lane play 
through this channel strip.

Â The right channel strip (if visible) corresponds to the first destination channel strip for 
the left channel strip. In essence, this is the first channel strip that the track channel 
strip is routed to. Generally, this will be an output channel strip (which represents the 
physical outputs of your audio interface) or an auxiliary channel strip, used as a send/
return bus, or as a sub-group mixer channel.

If the top of the channel strip is partially obscured, click the Region and Track/Channel 
Parameter box disclosure triangles to collapse one, or both, of these panels. 

The Arrange channel strips are identical to the channel strips in the Mixer window (see 
Chapter 7, “Mixing and Exporting Your Project,” and Chapter 5, “Using Instruments and 
Effects.”). Changes made to channel strips in either window are instantly reflected by 
their counterparts in the other window. 

Note:  The advantage of the Arrange channel strip is that it saves a visit to the Mixer 
window, in order to make a quick adjustment to a sound (volume or pan, for example). 
It also allows you to insert plug-ins and instruments, or change routings directly from 
the Arrange window, again saving you time.
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4 Editing MIDI Events

The individual events in MIDI regions can be edited. Most 
commonly, you will adjust the position, pitch, and length of 
MIDI note events. 

On occasion, you may need to alter other types of MIDI data, such as controller events. 
Â MIDI note event editing is best handled in the Piano Roll Editor. 
Â MIDI note events are represented as standard musical notation (and can also be 

edited) in the Score Editor. This primary purpose of this window, however, is the 
creation of musical scores for printing—rather than use as a MIDI note editor.

Â Other types of events are easiest to manage in either the Hyper Editor, or the Event 
List—although controller, and a few other event types, can also be directly edited in 
the Piano Roll and Score Editors, if you prefer.

Getting to Know the MIDI Editors
Before following the exercises below, choose either the Inst 1 or Inst 2 track. 

To open or close the Piano Roll, Score or Hyper Editor:
m Click the Piano Roll, Score or Hyper Editor buttons, just above the Transport. 

 

m Click the corresponding button to close the active editor window. 

The events in either the instrument Apple Loop, or your recorded MIDI region are 
shown as a series of beams in the Piano Roll and Hyper Editor, or as traditional notation 
in the Score Editor. 
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If necessary, resize the editor area, by dragging in the space between it and the 
Arrange area above. 

You can vertically slide the contents of the editor area by dragging the scroll bar at the 
right of the window. The horizontal scroll bar slides the window contents left or right (if 
some events in the region aren’t visible).

Take a look at all three editors, and keep an eye on the Inspector while doing so. Once 
you’re done, leave the Piano Roll Editor open.

Note:  Only one of these editors can be shown at a time in the Arrange window. You 
can, however, independently open any of these editors by choosing the appropriate 
item from the Window menu (in the main menu bar). This will open the editor in a 
discrete window.

Resize pointer
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To open or close the Event List:
1 Click the Lists button in the Arrange Toolbar (top right). 

The Lists area replaces the Media area, if open (the list editors available are:  Event, 
Marker, Tempo, and Signature—click the respective tabs to open each). 

 

2 Click the Event tab, if not already active.

The events in either the Software Instrument Apple Loop, or your recorded MIDI region 
are shown as a list. Columns indicate the position, length, value, and so on, of events.

To edit a note event position, do one of the following:
m Drag one of the beams (a note event) in the Piano Roll Editor to the left or right.

m Vertically drag on one of the Position column values in the Event List Editor.

As you do so, keep an eye on the help tag, and the other editor window. You’ll see that 
changes made in one are instantly reflected in the other.
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Editing and Creating Events
Full details on the use of each editor are found in the Logic user manual. For now, 
revisit the sections on “Selecting Regions” on page 23, and “Editing Regions” on 
page 38. All of the techniques for region selection and editing (except looping) also 
apply to event selection and editing. 

∏ Tip:  Don’t forget the shortcut menu, accessed with a right-click. Many “common” 
editing commands (also available in the Arrange and other windows) are found here, 
plus a few that are specific to the Piano Roll Editor.

Experiment with the Piano Roll Editor, where MIDI note events are represented much 
like Arrange window regions—as horizontal beams. The major difference is that 
moving a note event vertically—to another note’s lane—will alter its pitch.

A few techniques that were not covered in the region editing section—which you may 
find useful for event editing—are discussed below.

To create new note events in the Piano Roll Editor:
m Choose the Pencil tool, and click at the desired position (and pitch—aligned with the 

keyboard at the left).

 

You can also use this technique in the Event List and Score Editor windows, but it is 
easiest in the Piano Roll Editor.

To change the velocity of a note in the Piano Roll Editor:
m Choose the Velocity tool, and click-drag vertically on the desired note. 

 

The note color (and length of the line through the center of the note) will change as 
the velocity changes.

This technique also works on multiple selected notes, with the relative velocity values 
of each note (in relation to each other) being retained.
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To quantize one or more selected notes:
1 Choose the Pointer tool, and select the notes by clicking, Shift-clicking, or rubber 

banding.

2 Choose the desired quantization value in the Quantization menu at the top center of 
the Piano Roll Editor.

You can also click the Quantize button to quantize selected events (with the value 
chosen in the Quantization menu).

Quantization menu

Quantize button

Warning:  Once you have quantized individual events in the Piano Roll Editor, you 
should not use the Region Quantization parameter on the parent region. If you do 
this, all individual event quantization changes will be lost.
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5 Using Instruments and Effects

When you added the Software Instrument Apple Loop to the 
Inst 1 track, you undoubtedly noticed that the corresponding 
Arrange channel strip was filled with a number of new fields.

These are known as Insert slots, which are used for insert effects. Instrument channel 
strips also feature an Instrument slot (just below the I/O label on the channel strip). 

Software instrument plug-ins can only be inserted into instrument channel strips. The 
method is the same, regardless of the instrument you choose. You can do this from the 
Mixer window, but it’s faster and easier to use the Arrange channel strip, at the bottom 
of the Inspector. You can also make use of the Library, which is discussed in the 
following section.

Before beginning this exercise, click the Media button (at the right-hand end of the 
Arrange Toolbar), and click the Library tab, if not already chosen.

Channel Strip Settings menu

Instrument slot

 Send slot

 Insert slot
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To directly insert an instrument into an instrument channel strip:
1 Click the Inst 2 track name in the track list. 

The Inspector updates, to reflect your selection.

2 Click the Instrument slot (the slot just below I/O) on the left Arrange channel strip. 

 

A menu of all available software instruments is shown. 

3 Simply click the ES E (Ensemble Synth) name, and the ES E synthesizer will be loaded 
into this instrument channel. 

The ES E plug-in window automatically opens. The Library to the right of the Arrange 
window also updates, showing a list of all settings (preset patches) for the ES E. 

4 Click on any of the setting names (in the Library) to load the preset into the ES E. Try 
this with a few settings, playing your keyboard after you’ve loaded each new patch.

∏ Tip:  An alternative way to load settings is found in the plug-in window header. This is 
discussed in “Editing Instruments and Effects” on page 58.
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To directly insert an effect into a channel strip:
1 As the Inst 2 track is already selected, simply click the top Insert slot (the slot just below 

Inserts) on the left channel strip. 

A menu of all available effect plug-ins is shown.

 

2 Hover the mouse pointer over the Distortion menu item, and click on Bitcrusher in the 
sub-menu. 

The Bitcrusher is loaded into the top Insert slot of this instrument channel. Its plug-in 
window automatically opens. The Library tab to the right of the Arrange window also 
updates, showing a list of Bitcrusher settings. 

3 Choose any of the Bitcrusher settings. Try this with a few settings, playing your 
keyboard after you’ve loaded each.

4 Repeat these steps to insert further effects into Insert slot 2, slot 3, and so on.

∏ Tip:  An alternative way to load settings is found in the plug-in window header. This is 
discussed in “Editing Instruments and Effects” on page 58.
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To directly insert an EQ into a channel strip:
m As the Inst 2 track is already selected, simply double-click the EQ panel at the top of the 

left Arrange channel strip. 

 

A Channel EQ is automatically inserted into the top Insert slot (or the first available 
Insert slot if the top one is already used, which it would be if you’ve followed the steps 
above).

The effects are chained, from the top Insert slot to the bottom.

∏ Tip:  Typically, audio is EQ-ed before being processed with other effects, but there are 
no “absolutes” when it comes to achieving the sound you’re after.

To replace an inserted plug-in (effect or instrument):
m Click on the desired slot, and choose a different type of plug-in from the menu.

If the plug-in window is open, it will update to reflect the newly selected plug-in. If not 
open, a new plug-in window is launched.

To remove an inserted plug-in (effect or instrument):
m Click on the desired slot, and choose “No Plug-in” from the menu.

You can also bypass a plug-in. This leaves it in the insert or instrument slot, but the 
signal is routed “around” the plug-in.

To bypass an inserted plug-in (effect or instrument), either:
m Option-click on the desired slot of the channel strip (Mixer or Arrange). 

The Insert slot of the bypassed plug-in turns from blue to gray, indicating that the plug-
in is currently bypassed. 

m Click on the Bypass button at the top left of the plug-in window header. 

Using the Library
The Library, as you’ve discovered, lists and categorizes all effect and instrument plug-in 
settings. It goes even further than this, however, updating to match:
Â The selected channel strip type
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Â The selected channel strip section:  EQ, Instrument slot, Insert slot, Channel Strip 
Settings slot

This interaction with different parts of the Arrange channel strips makes it very easy to 
reconfigure your effects routings and settings. It also simplifies a number of mixing and 
recording tasks. 

To open or close the Library:
1 Click the Media button in the Arrange window Toolbar (top right).

2 Click the Library tab, if not already active.

The Library will also automatically open when you create new tracks, as you discovered 
earlier. This feature can be disabled in the New Tracks dialog, if you wish.

Using the Library to load complete channel strip settings:
1 Click the Inst 3 track name in the track list to select the track. The Inspector and Library 

update, to reflect your selection.

2 Click any of the categories shown in the Library:  01 Pianos, 02 Electric Pianos, and so 
on.

3 Click any of the sub-categories shown in the second column of the Library (if 
applicable). A third column is shown.

4 Click on any of the settings shown in the second or third column. Play your keyboard 
after loading each setting.

You will see that the left Arrange channel strip automatically updates—usually with at 
least two or more (blue) Insert slots, plus the Instrument slot—being activated. These 
are known as channel strip settings, rather than individual instrument settings. Not only 
is an instrument plug-in loaded, but also all effect plug-ins used by the channel strip. 
Even better, the setting of each plug-in (instrument and effect) is automatically loaded!

To quickly change loaded effect or instrument settings:
1 Click any of the used Insert or Instrument slots on the Arrange channel strip. 

A white frame is shown around the selected slot, and the Library updates.

2 Choose another setting in the Library to load it for the selected effect or instrument type.

 A white frame indicates
the Library focus.
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Editing Instruments and Effects
As you’ve discovered, an instrument or effect plug-in window opens when inserted into 
a channel strip. Full details on the parameters, and use, of each plug-in are found in the 
Instruments and Effects manual. For now, here are a few basics on the plug-in window.

To edit plug-in parameters:
m Simply click on switches or buttons to turn the parameter on or off.

m Drag vertically on knobs to alter the parameter value.

m Drag slider handles to adjust the parameter value.

m Option-click on any (non-switch) parameter to reset it to the default value.

Give all of these a try with the ES E instrument part that you recorded earlier. Your 
parameter changes can be saved as a new plug-in setting. You can also record 
parameter changes in real time, using track automation. More on this in “Automating 
Your Mix” on page 67.

To open the ES E plug-in window if it isn’t open:
1 Click the ES E track name (the sixth track) in the track list.

2 Double-click on the ES E Instrument slot of the Arrange channel strip. 

The ES E plug-in window will open.

A double-click on any active EQ, Insert or Instrument slot will open the plug-in window, 
unless already open. In this case, the corresponding plug-in window is given key focus.

∏ Tip:  If the Link button is active in an open plug-in window, double-clicking on another 
Insert or Instrument slot will update the plug-in window, to show the corresponding 
plug-in (thus saving space on screen). If the Link button is not active, a new plug-in 
window is launched. Give the linked and unlinked modes a try on the Inst 1 track.

Click here to load, save, 
or copy a plug-in setting

Click here to bypass a
plug-in

Click here to close a
plug-in window
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6 Working With Audio Files

Projects can potentially contain thousands of audio files that 
you need to manage and edit.

Audio file management tasks, such as renaming, creating backups, or converting to 
other formats are best handled in the Audio Bin. 

Many audio file handling tasks, such as resizing, can be performed on regions—rather 
than editing the underlying audio file. When you require extremely precise audio edits, 
however, it’s best to use the Sample Editor.

Editing Audio Files
Even though the Arrange window allows you to edit regions with sample accuracy, 
there are a number of jobs that you may need to perform directly on the underlying 
audio files. As examples:
Â Precisely setting the start and end points of an audio file when creating a loop.
Â Changing the “downbeat” (known as the anchor in Logic) to ensure that your audio 

file plays at exactly the right time.
Â Reversing the audio file.
Â Maximizing the gain, without clipping the audio file (a process known as 

normalizing).
Â Removing pops or clicks in your audio files.

All of these tasks, and many others, can be performed in the Sample Editor. Full details 
on all Sample Editor commands and functions, along with usage examples, are found 
in the “Editing Audio in the Sample Editor” chapter of the Logic user manual.
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To open the Sample Editor, do one of the following:
m Select an audio region or file (in the Arrange area or Audio Bin), and open the Sample 

Editor by clicking on the button above the Transport bar.

m Double-click on an audio region or file (in the Arrange area or Audio Bin). 

Important:  All edits and processes performed in the Sample Editor are destructive! This 
means that the audio file is actually altered. While you can certainly undo edits and 
processing commands, you should get into the habit of working on copies of your 
audio files, rather than the originals. It’s better to be safe, than sorry.

 Ruler

Info display

 Waveform display

 Anchor

PlayheadRegion area Waveform overview

Play button Loop button
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Managing Your Audio Files
Once an audio file (of any supported format) has been added to, or recorded in, your 
project, it will appear in the Audio Bin (Media area). You can also directly import audio 
files into the Audio Bin. The Bin can be viewed as an audio file catalogue for your 
project. It also displays regions, derived from imported audio files.

Click the Bin tab at the top of the Media area to take a look at the files you’ve imported.

You can directly drag files from the Bin into the Arrange area. All Audio Bin functions 
and commands are covered in the Logic user manual, but you should take a few 
minutes to explore the menus, and follow the exercise below.

To export an audio file as an MP3 file:
1 Click on an audio file name (not a region) in the Bin.

Note:  You can not convert Apple Loop files with this function, so choose another file.

2 Choose Audio File > Copy/Convert Files (or use the key command:  Control-C). The 
Copy/convert dialog opens.

3 Click the File Format menu, and choose MP3.

4 Click the Save button.

Regions associated with 
audio file. The bars reflect 
the relative length and 
portion of the file.

Audio file info
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7 Mixing and Exporting Your 
Project

The Mixer window can show all, or some, of the channel 
strips used in your project. 

While most mixing tasks can be achieved with the Arrange channel strips, you may 
prefer to use the Mixer—particularly as your arrangement grows, or once you’ve 
finished the recording phase of your project, and are ready to “polish” your mix.

To open or close the Mixer window:
m Click the Mixer button, just above the Transport.

The default Mixer view shows all channels, as used by Arrange window tracks.
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To change the Mixer view:
m Click on the Single, Arrange, or All buttons at the top of the Mixer window.

Â Single:  Shows all channel strips in the signal path of the selected track.
Â Arrange:  Shows channel strips that correspond to tracks used in the Arrange window.
Â All:  Shows all channel strips in the project.

m The Audio, Inst, Aux, and other buttons to the right act as “filters.” You can click one or 
more of them to refine the Mixer view.

These buttons limit the display to particular channel types, which can make your life 
much easier if working with large numbers of channels.

The channel strip of the selected track (in the Arrange window) is outlined in green, 
making it easy to identify.

To select a different track/channel:
m In the Mixer:  Click the name at the bottom of the desired channel strip. 

The corresponding Arrange track is selected.

m In the Arrange area:  Click the track name in the track list.

The corresponding channel strip is selected in the Mixer.

Using the Channel Strip Controls
This section will teach you the basics of using channel strips. The various channel strip 
types offer different functionality, as discussed in the Logic user manual. 

Pan/Balance control

Level fader
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To adjust the level of a channel strip:
m In either the Mixer or Arrange (channel strips), grab the Level fader, and move it up or 

down.

A channel strip does not need to be selected in the Mixer to adjust parameters.

To adjust the panning (or balance) of a channel strip:
m Click on the center of the Pan/Balance control, and move the mouse vertically. Upwards 

movements pan to the right, and downwards movements pan to the left. 

Adjustments pan the signal to the left or right on mono channels, but alter the balance 
between the left/right signals on stereo channels.

Changing the Routing of Channel Strips
It can be useful to send the signals of several channels to other channels, for a couple 
of reasons:
Â To share effects processors, such as a reverb or delay plug-in. This saves computer 

processing resources, as only one plug-in is used by all channels. Creatively, this can 
also ensure that a particular color, ambience, or timing (in the case of delays) is 
applied to all routed channels.

Â To sub-group several channels, such as a string section. This makes it easy to fade out 
all strings, while raising the level of the horn section (several channels routed to a 
different sub-group), for example.

Auxiliary channel strips are used for both purposes. 
Â When used as effect send/returns, simply insert the desired effect plug-ins into the 

auxiliary channel. The signals of channel strips sent to the aux channel strip are 
processed through plug-ins (on the aux channel), and returned to the channel 
strip(s).

Â When aux channels are used as sub-groups, you can alter the panning and level of all 
channels routed to the aux by adjusting these controls on the auxiliary channel strip.
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To send a channel to a bus:
m Click the top, unused Send slot of any channel, and choose Bus 1 from the menu.

The following happens:

Â A new auxiliary channel strip (Aux 1) is created in the Mixer—with Bus 1 shown in 
the Input slot (I/O section).

Â A blue Bus 1 label appears on the Send slot of the channel, along with a small Send 
Amount knob to the right of the slot.

To adjust the amount of the channel signal sent to the bus (aux channel):
m Vertically drag the Send Amount knob. 

The use of EQ, instrument and effect plug-in slots—on all types of channel strips—is 
discussed in Chapter 5, “Using Instruments and Effects.”
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Automating Your Mix
At this stage, you’ve seen how many controls and parameters are available in the 
channel strips, and several plug-ins. Changes that you make to virtually all of these 
controls and parameters can be recorded and played back, just like your MIDI and 
audio performances. This allows you to create complex, animated mixes—with 
automatic channel mutes, signals that pan from side to side, synthesizer filter sweeps, 
channel groups slowly fading in or out, and much, much more.

Recording and playback of these changes is known as mix automation. There are 
several ways to do this in Logic, but the easiest, and most powerful method is with 
track automation. As the name suggests, the automation information is stored on 
automation tracks in the Arrange window. These tracks are independent of MIDI and 
audio regions.

Track automation data is displayed on a semi-transparent gray area—an automation 
track—that runs the length of your project. The audio waveforms of audio regions, and 
notes in MIDI regions, can be seen at a reduced contrast level in the shaded area. The 
automation information itself is represented by colored curves, dots (known as nodes) 
and lines—shown in the gray automation track lane.



68 Chapter 7    Mixing and Exporting Your Project

To display track automation in the Arrange area, do one of the following:
m Choose View > Track Automation in the Arrange area (or use the View Track 

Automation key command, default:  A).

m Click the Automation button in the Arrange Toolbar.

A gray automation lane appears on all tracks, and the Automation Parameter menu is 
displayed in the track header. This allows you to choose the visible automation 
parameter. It is automatically set to Volume.

Automation can only be displayed when a track is of a sufficient height. Turning on 
track automation will automatically set a suitable vertical zoom level. 

To choose an automation parameter:
m Click on the Automation Parameter menu, and browse to the desired parameter. 

A sub-menu is shown for each plug-in inserted in the channel strip. These are 
numbered and named after the slot position and plug-in. Further sub-menus may be 
shown inside the plug-in menus. Volume, Pan, Solo, Mute, and Bypass are shown in the 
Main sub-menu.

 Automation Parameter
menu
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To write volume automation to an automation track:
1 Ensure that Volume is shown in the Automation Parameter menu.

2 Choose Touch, Latch, or Write in the Automation slot of the Arrange channel strip.

3 Start playback by clicking the Transport bar’s Play button.

4 Move the Level fader on the Arrange channel strip.

5 End automation recording by clicking the Transport bar’s Stop button. 

Note that the Automation slot of the channel strip automatically switches to Read. 

6 Press play to hear your newly automated track.

This procedure can be repeated for any active parameter (the one shown in the 
Automation Parameter menu).

You can also “write” automation by choosing the Pencil tool, and clicking at various 
points in the automation track. Nodes are created at click points, and connecting lines 
are automatically created between nodes.

Note:  Parameter names (or automation track lanes) do not need to be visible in order 
for automation to be played back.

To edit the volume automation track:
1 Choose the Automation or Pointer tool.

2 Click on any of the lines, nodes, or curves, and drag them up or down, or to the left and 
right.
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Exporting Your Project
Once you’ve recorded and mixed all parts, you will generally want to export your song 
as an audio file—for use on a CD, internet delivery, playback on your iPod, and so on. 
This is achieved through a process known as bouncing.

To bounce your mix:
1 Click the Bounce button, towards the right of the Arrange Toolbar. 

2 In the Bounce dialog, use the settings shown in the image below to create a file that is 
suitable for CD delivery. 

3 Click the Bounce button, and a real time bounce will take place. The file will be added 
to the Audio Bin window and your iTunes library.

Note:  The Start and End fields will automatically encompass all audio regions in your 
project, unless Cycle mode is active—so make sure it isn’t. If it is, click Cancel, click the 
Cycle button on the Transport bar, and re-open the Bounce dialog.
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8 Speeding Up Your Workflow

There are hundreds of functions and commands in Logic, and 
as many ways to use them.

Ultimately, it’s your choice as to how you want to approach music making in Logic, as it 
generally allows you to work in a way that makes most sense to you. Most importantly, 
any customizations you make should accelerate and simplify your workflow.

Using Key Commands
You can activate most Logic functions and operations with computer keyboard 
shortcuts, known as key commands. In fact, a number of functions are only available as 
key commands. Where possible, you should use these shortcuts, as they are far faster 
than using the mouse.

The Key Commands window is used for the assignment of key commands to your 
computer keyboard. Customized key commands allow you to reconfigure Logic to suit 
your own working style. Your personalized key commands are stored in the Logic 
preference files. 

Full details on the Key Commands window (which is opened via the Logic > 
Preferences > Key Commands menu option or with the Option-K key command) are 
found in the Logic user manual.
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Using Screensets
Every project created in Logic can contain up to 90 screensets. Screensets are window 
combinations that can be customized by you, and stored to numeric computer 
keyboard keys/key combinations. Each screenset remembers the type of editor or 
Arrange windows opened, plus their individual size, position, and zoom settings. This 
facility accelerates your workflow massively, and allows you to tailor Logic to fit your 
needs and tastes. 

∏ Tip:  Screensets are particularly useful if using multiple monitors or wide screen 
monitors. You can position and size elements anywhere, on any monitor.

To set up a screenset:
1 Press any of the numeric keys above your computer keyboard (you can also use a 

numeric keypad, if using a portable Macintosh).

2 Open the desired windows by choosing them from the Windows menu, or by using the 
appropriate Key Commands.

3 Resize, zoom, and reposition your selected windows to meet your needs. All changes 
you make are remembered automatically. 

Resizing and repositioning of windows is as per any Mac OS X application. Zooming 
the content of individual windows is achieved with the Zoom sliders.

Note:  This will only work for keys/screensets 1 to 9. 

To set up more than nine screensets:
m Press Control while typing in the desired numeric key combination.

Important:  You can not use the number “0” for any of your screenset combinations. The 
reason is that this numeric key is “hard-wired” to the Play function key command.

To recall a screenset, do one of the following:
m Press the appropriate key or key combination. 

Hold Control, and press the appropriate number keys to recall screensets 11 and above.

m Choose the desired screenset from the Screenset menu.

To prevent the current screenset from being altered:
m Choose Screensets > Lock Screenset (or use the Lock/Unlock Current Screenset key 

command, default:  Shift-L).

A bullet appears in front of the screenset number to indicate that it is locked. Reuse the 
key or menu command to unlock the screenset.
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Using Control Surfaces
Any device used to remotely control Logic functions is known as a control surface. 
Many Logic operations, including control of channel strip parameters, execution of key 
commands, screenset switching, track arming, muting, soloing, transport functions, and 
much more—can be done remotely, with any MIDI device, such as your MIDI keyboard. 

More flexibility is offered by dedicated hardware controllers, however. Typically, these 
devices will contain several channel strips—each with a fader, knob, and one or more 
switches. Most also offer dedicated transport buttons:  Play, Stop, Record, Rewind, and 
Forward. Higher end units have LCD displays, jog wheels, and a number of reassignable 
function buttons.

Control surfaces can massively accelerate your use of Logic—particularly for mixing 
and automation recording tasks. Obviously, if automating or changing volume with the 
mouse, you can only control this one parameter—on one channel—at a time. With a 
control surface, you can simultaneously automate or alter the volume of several 
channels (as many channel faders/knobs as you can move at a time on the control 
surface).

Other tasks, such as software instrument or effect programming and automation, can 
also be made simpler with a control surface—which provides dedicated faders or 
knobs (the channel strip controls are reassigned) for plug-in parameters. This gives you 
simultaneous, direct control of a synthesizer plug-in’s filter cutoff, filter resonance and 
LFO speed parameters, for example. 

Not only is this faster, but the “feel” and “mix balance” of your music can be enhanced 
by using your hands and ears, rather than your hands and eyes.

Many control surface devices are natively supported. You can freely reconfigure these, 
or unsupported devices, in the Logic > Preferences > Control Surfaces > Controller 
Assignments window.
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A Audio and MIDI Basics

This appendix offers a brief overview of MIDI and digital 
audio basics.

If you want to know what an audio file is, how audio is converted into (and from) 
computer information, and what this MIDI thing is all about, you’ll find it here.

MIDI
MIDI is an acronym for Musical Instrument Digital Interface. To break this down 
further—the Musical Instrument part of MIDI refers to electronic musical instruments 
such as synthesizers, samplers, and even MIDI guitars. The Digital Interface part sounds 
technical, but really isn’t. 

Basically, MIDI’s Digital Interface is broken down into two components.
Â MIDI is a computer-based language—and as you probably know, computers talk 

digitally. MIDI keyboards, modules, and cards are actually computers in disguise.
Â MIDI’s Interface is just that. MIDI is a hardware standard which consists of a set of 

physical connectors labeled IN, OUT, and THRU. You will find one or more of these 
connectors on all MIDI devices, such as keyboards or modules.

The MIDI Language
The “language” of MIDI is understood by all MIDI devices. The purpose of the language 
is to translate your musical performance into information that can be understood by a 
computer. (Don’t forget that MIDI keyboards and modules are actually computers in 
disguise).

When you play your keyboard, or Logic is playing a MIDI song file, MIDI information—
which “describes” your performance—is transmitted as a string of MIDI messages. 
These messages are instructions which tell any connected synthesizer or sound module 
how to play a piece of music. The synthesizer or module receiving the MIDI data 
actually generates the sounds that you hear. 

Important:  MIDI does not send sounds. It only sends instructions.
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The MIDI Connection
MIDI, as mentioned, is also a hardware “interface” which consists of a standardized set 
of connectors labeled IN, OUT, and THRU.

MIDI connectors consist of a round socket with five holes arranged in a semicircle. MIDI 
cables, used for connecting MIDI devices, have a matching plug that features five pins. 
Only three of the pins actually carry information.

MIDI only works in one direction on each connector. If you want your MIDI keyboard to 
send messages to, and receive messages from Logic, you must connect two cables.

Here’s the way your MIDI connections must be made, in order to work:
Â MIDI OUT sockets must be connected to MIDI IN sockets on the receiving device.
Â MIDI IN sockets must be connected to MIDI OUT sockets.

The MIDI THRU connector is not found on all MIDI devices. It simply mirrors the MIDI 
messages arriving at the MIDI IN socket, and allows you to “daisy-chain” more MIDI 
devices. 

MIDI messages are sent from a MIDI controller such as a keyboard or sequencer—such 
as Logic—via the MIDI OUT connector. The device (MIDI synthesizer or sound module) 
receiving the MIDI messages at its MIDI IN socket, responds to these messages by 
playing sounds. 

Important:  Remember, MIDI does not send sounds. It sends instructions on how, what 
and when to play.

Audio
Audio, as a term, basically refers to any sound that you can hear. In the physical, as 
opposed to computer world, this is known as analog audio. When Logic records analog 
audio signals via an audio interface connected to, or installed in, your computer, the 
audio is converted into digital information. This information is stored as a digital audio 
file on your computer hard disk. 

As with MIDI, the digital part sounds technical, but really isn’t. As discussed earlier, 
computers talk digitally, and need to deal with analog audio signals as digital 
information.

Important:  Unlike MIDI, digital audio files are actually recordings of sounds, not an 
instruction language.
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Digital and Analog Recording
While digital audio recording is similar in concept to analog recordings made on tape, 
the technical differences are significant. For much of the 20th century, and into the 
21st, analog tape recordings have been used for the storage of audio performances—
spoken, sung, and played. 

The analog tape medium is a thin plastic strip coated in tiny metal particles. It is usually 
stored on a roll or spool, or as a cassette tape.

The process of analog tape recording involves the transmission of small electrical 
charges, sent to the magnetic heads of a tape recorder. Changes to the strength of 
these charges alter the magnetic fields generated by the heads, and rearrange the 
positions of the metal particles on the tape. Needless to say, this is a less than precise 
science. Due to the randomness involved in the rearrangement of magnetic particles 
on tape (and other technical reasons), the recordings are said to be analogous—similar 
to the actual performance.

Digital recording, on the other hand, is much less random. Analog signals are 
converted into digital audio signals via the ADC (Analog to Digital Converter) of the 
audio interface. The digital audio signal is stored on your computer hard disk—as a 
series of ones and zeroes—in a digital audio file. Provided this file remains uncorrupted 
(and is not edited or altered), the digital recording will be identical each time it is 
played back.

In a copying situation—tape to tape—there is no comparison between analog and 
digital recordings. Each subsequent copy of an analog recording becomes noisier, and 
less like the source material. This is the random factor of the magnetic particles 
becoming less like the original each time a copy is made.

Digital audio files, on the other hand, can be copied any number of times, with each 
subsequent copy adding no noise. It is simply a file copy.

On a more practical level, digital audio files stored on hard disk have the following 
advantages over analog audio stored on tape.
Â Digital audio can be cut, copied, and pasted freely from location to location. Could 

you imagine physically cutting a stereo analog recording stored on tape into even 
four or five segments, and splicing them back together? Not much fun!

Â You can move to any spot in a digital audio file almost instantly, rather than waiting 
for the tedious mechanical rewinding and fast forwarding of an analog tape 
machine. 

Â You can process digital audio in ways that are simply impossible with analog audio. 
As one example, it is possible to adjust the pitch of a digital audio file without 
changing its speed.
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Digital Conversions
When an analog audio signal arrives at the inputs of your audio interface, it must be 
converted into digital information before the computer can deal with it. This process is 
called analog to digital conversion—handled by the Analog to Digital Converter (ADC) 
of your audio interface. 

At the other end of the signal path, the digital signal needs to be reconverted into an 
analog signal, so that it can be heard through analog audio playback systems—an 
amplifier and speakers. This process is called digital to analog conversion, which is 
performed by the Digital to Analog Converter (DAC) of your audio interface.

About Bits and Sampling Rates
When recording a sound into your computer, the ADC of your audio interface takes a 
sample of the sound source, a specific number of times per second. This is known as 
the sample rate, which is measured in kHz (kilohertz—kilo means thousand) or “x” 
thousand samples per second. The higher the rate, the more samples the AD converter 
takes, and the more accurate the digital representation of the sound will be. 

Put another way, imagine each sample to be a photograph of a concert that you are 
trying to describe to a friend. If you had taken one photo every 10 minutes, you’d find it 
hard to describe the great light show. If you took a thousand photos during that 10 
minutes, your friend could easily see what happened. This increased “rate,” or number 
of photos (samples), delivers a far more accurate overall picture of what happened. This 
is how sampling works. The more “sonic photos” taken, the more accurately the sound 
is represented over time. A videotape recording of the concert—running at 25 frames 
(samples) a second, would give an even more accurate idea of the light show.

Common sample rates used in audio production include:  44.1 kHz or 48 kHz, and high-
end systems may use rates from 96 kHz up to 192 kHz.

The sampling resolution—expressed as bit values—determines the precision of the 
measuring scale used to store (the numbers of ) each sample. Remember that 
computers store audio files as digital information—a series of ones and zeroes. There 
are three audio file resolutions commonly in use:  8, 16, and 24 bits. 24 bit systems are 
commonly used these days. 

To give you an idea of the relevance of the sampling resolution, imagine two people 
are building a house. One is using a tape measure marked to the nearest foot. The 
other has a tape measure marked to the nearest inch. Although the house built with 
the tape measure accurate to the nearest foot may not fall down, the person using the 
finer scale will build a more accurate house.
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B Audio and MIDI in Mac OS X

This chapter covers the audio and MIDI facilities of Mac OS X.

Your audio and MIDI hardware can be used by all “media-aware” applications in 
Mac OS X. This is achieved through the use of the operating system’s Core services.

Core Audio
All audio devices are accessed via Core Audio in Mac OS X. Core Audio is a flexible, 
high-performance, low-latency audio system. Logic is compatible with any audio 
hardware that is supported by a Core Audio driver.

Sound Preference Pane
The Sound preference pane is only required for switching the system’s Sound Effects 
(“Sosumi,” “Ping,” and others …). 

If you are on the road with your portable Macintosh, and want to quickly try out a 
musical idea, you might want to use the internal microphone for recording. Select 
Apple () menu > System Preferences > Sound, and then Input. Switch between Line 
In and the Internal microphone in this pane.

Select Apple Menu > System Preferences > Sound, and then Output. This preference 
pane determines the default output device. This output device is used for system alert 
beeps, and for some audio applications, such as iTunes and iMovie. If you would prefer 
to output your system beeps (and playback of iTunes and iMovie audio) via external 
Core Audio hardware, select your device here.

Note:  You can set an independent level for the alert beep. It is recommended that you 
reduce this to the minimum level, or even deactivate alert beeps entirely, when 
working on compositions.

You should always select the maximum possible volume level, in order to make full use 
of the entire dynamic range, when working with applications that use the default 
output.
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Note:  Reduce the level setting of your amplification system when adjusting the 
volume, to avoid any speaker damage.

Audio MIDI Setup (AMS)
Apple’s Audio MIDI Setup application is integrated into the operating system. The AMS 
application is found in the Applications/Utilities folder. 

Note:  You may find it useful to move the AMS application into the Dock. 

As AMS mirrors the parameters of the Sound preference pane (except for Sound 
Effects), it should be used for almost all adjustments to your audio interface settings. 

The AMS application is useful for choosing a default setting for your Core Audio 
hardware. You will require this default setting for all audio applications (iTunes, for 
example) that are incapable of directly selecting a setting. For more capable audio 
applications, such as Logic, it is possible to set all parameters from within the host 
itself.

Note:  The appearance of the AMS application may vary, dependent on the version of 
Mac OS X in use.

Core MIDI
MIDI data is handled by the Core MIDI system of Mac OS X. Compatible MIDI 
interfaces—used to connect MIDI keyboards, fader units, or external sound 
generators—are recognized and activated automatically.

The MIDI Page of AMS
The AMS application offers a MIDI page that displays all installed MIDI interfaces, and 
make connections between them, if necessary. Logic recognizes all MIDI devices 
(including MIDI sub-channels) set up in AMS, and displays these in the Library when an 
external MIDI track is selected or created.
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C Optimizing Your Computer Audio 
System

Logic is known for its stable and reliable operation. You can 
further enhance your system performance by optimizing your 
computer configuration for music applications. 

Outside of music, a well-configured and well-maintained computer performs more 
reliably, with fewer crashes, and that’s got to be a good thing! The following pages 
feature tips and tricks that may help you to optimize your computer configuration. A 
first-aid kit—for computer emergencies—is found at the end of the chapter. 

Hardware
Obviously, the fastest Mac you can afford will be the most appropriate computer for 
use with Logic. If you can stretch to a multi-processor Macintosh, do so. Logic, and 
Mac OS X itself, is built to make use of multi-processor Macs.

In general, you should avoid “weighing down” your computer system with unnecessary 
components, so don’t add a SCSI card if you can make do with FireWire or internal 
drives.

You should concentrate much of your effort on the selection of the “right” audio 
hardware, to ensure that it is compatible with your software and other computer 
hardware components. 

Memory
An adequate amount of RAM is important for the overall stability of your computer 
music system. At least one gigabyte (or more!) of high-quality RAM is recommended, 
particularly when working with numerous audio tracks or software samplers. 

Hard Drive
If your “day-to-day” work involves a large number of audio tracks, consider using a 
separate, fast hard drive with enough storage capacity for your audio files. FireWire is a 
good choice for these sorts of duties. 
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Audio applications place high demands on the platters and mechanical parts of a hard 
drive. Regular hard drive maintenance is particularly important for ensuring stable, and 
consistent, drive operation. This includes de-fragmentation and performance checks. 
Frequent de-fragmentation has a positive effect on the life of a hard drive. The hard 
drive tools that ship with the operating system are a safe choice but these may not 
detect, or repair, all problems.

Note:  As a general rule, the larger the hard drive, the less frequently it will need to be 
defragmented.

Hard drives are subject to wear-and-tear. Should your hard drive utility detect problems 
more and more frequently, it might be a precursor to a drive failure. Back up your data 
and consider replacing the drive before a total failure occurs.

Software
When deciding on software to install on your computer music system, the general rule 
is “less is more.” Ideally, only the standard operating system plus Logic, and maybe the 
components required for accessing the Internet, would be installed on your system. In 
the real world, however, this isn’t always practical …

You should avoid running other applications—unless absolutely necessary—while 
using Logic. Mac OS X is very good at multi-tasking, but why take away any potential 
power from Logic? Running that word processor in the background, or leaving your 
Internet connection “live” could cost you that “one last” reverb you need to finish a 
track.

Backup
The most important rule when using computers:  Always back up your data! 

This is particularly true for a computer music system, as you will generate huge 
amounts of data in a short amount of time—often under demanding conditions. 

For this reason, it’s a good idea to back up your most important data on several 
external storage media—on a daily basis! If this seems a little paranoid, just consider 
the price of storage media compared to the value of your music. If your computer (or 
hard-disk) decides to self-destruct, the result is often the unrecoverable loss of 
important data, and with it, hours of work and inspiration. 

If you make your living with a computer music system, you might want to invest in a 
professional backup solution—see your music/computer dealer for further information 
and assistance.
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Troubleshooting
They may be rare, but every computer user inevitably experiences seemingly severe 
computer problems, at some point. These may be crashes where the mouse freezes, 
the screen locks up, or the display is plastered with error messages. Even mature, well-
written operating systems cannot protect you completely from hardware conflicts, 
bugs, or other problems.

Experience has shown that such system problems are rarely caused by a defect in 
Apple programs or hardware products. All Apple hardware and software is rigorously 
tested by a diverse range of musicians and studio users, from a variety of fields and 
uses, who look for any faults or problems.

This doesn’t mean that the possibility of errors can be completely ruled out; problems 
can crop up periodically. This is not unexpected—as the various applications, operating 
system versions, and drivers—are all developed, and improved in parallel by unrelated 
programming teams. This can lead to occasional compatibility problems. Apple 
provides fixes in the form of software updates, as soon as such problems are identified. 
Apple is always grateful to users who report any problems.

If you suffer from system crashes or errors, you may find the tips in this chapter helpful, 
even if the problems are ultimately unrelated to Apple products. In most cases, these 
problems, once identified, can be rectified with a minimum of effort, although tracing 
the cause of such problems can be time consuming. You can overcome most of these 
problems without needing to consult an expert—this chapter will guide you on how to 
proceed. It is best to eliminate the classic causes of problems before you suspect a 
hardware defect, or another fault—especially before sending your machine in for 
repair, or your software for a refund. Take care, though:  some of these suggestions may 
only cure the symptoms, and could therefore complicate the identification of the actual 
cause of the problem. Persistent problems will require the advice of an expert.

If you bought your computer and audio hardware at the same time, it is a good idea to 
test that the computer is functioning as expected—with just a mouse, keyboard, and 
display attached—before installing the audio interface and additional hardware 
(external hard disks, printers etc.). All new Macintosh computers ship with pre-installed 
software, which should allow you to test that everything is working correctly. Once you 
have switched everything off, you can proceed with the installation of any additional 
hard disks, modems, scanners, and so on, if applicable. Once done, check that 
everything is working as it should be. If so, you can unplug all cables from the back of 
the computer and begin the installation of your audio hardware.
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If Disaster Strikes
Your first priority should be to make a backup of your most important documents. 
Attempt to copy your files (lyrics, songs, tax records) to other hard, or removable drives, 
without launching their associated applications. You can skip this step for CD-ROMs, 
but be aware that even CDs require a little care when handling:  neither side of the disk 
should be scratched. Once you have made backups of your files and programs, the 
chances of a true disaster are all but eliminated. Never skip making regular backups, 
even if everything is working perfectly—eventually, any hard disk may crash! 

A system crash can be caused by:
Â Operator error
Â A software conflict (incompatibility between two programs, or a virus)
Â A hardware configuration error
Â Overloading the system’s resources
Â Faulty cable connections (or missing termination)
Â A hardware defect

Eliminate the first five causes before deciding to have your hardware repaired.

If the problem persists, make precise notes of the following:
Â What you were doing at the time of the error (which program, which function, which 

applications were open).
Â The exact text of any error messages and/or error numbers (if applicable).
Â The version of the operating system, as well as that of the program in which the error 

occurred.
Â The Apple System Profiler, installed with Mac OS X, offers an in-depth component 

overview, which can be printed.
Â Which System Preferences (found in the Apple menu) are active.

Note:  The Apple System Profiler can be used to print details of your entire system 
configuration, including the properties of all hardware.

Preferences and Parameter RAM
Many crashes can be avoided by taking one of the following measures (please exit the 
program first):
Â Move or delete the preferences of the program that is crashing. The preferences files 

are found in your User folder ~/library/preferences. Drag the preference file to the 
desktop. Doing so will often require you to reset some of your program’s preferences.

Â “Zap” the Parameter-RAM (P-RAM). This contains clock time, date, and many system 
settings which are preserved when the computer is turned off. You can easily reset 
them. Hold the Command-Option P and R keys during a restart (immediately after 
hearing the start sound). Keep the keys held until you hear the Macintosh start 
sound three times.
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Does the problem persist?

Hard Disk Checking and File Structure Repair
Logical file structure errors can be diagnosed and repaired with suitable software. Hard 
disk hardware defects can also be diagnosed. The boot drive (Start Volume) cannot 
generally be repaired if a critical error occurs. If you usually start your computer from 
the internal hard drive, you will need to choose another Start Volume, which will boot 
the computer from another drive. This is best accomplished with the emergency CD-
ROM that came with your Macintosh, but you may also need a second hard (or 
removable) disk drive with a system folder on it.

Choose the CD-ROM, or other drive containing the operating system, in the Start 
Volume control panel. Restart the computer. Many Macintosh computers also allow you 
to force a start from the CD-ROM by holding down the C key during a new start.

Launch the Hard Disk Utility program, and use it to repair your volumes.

Does the problem still persist?

PCI Errors
PCI technology relies on highly-accurate timing synchronization in your computer’s 
data stream. Unfortunately, there are certain PCI (or PCI-X) card combinations that will 
cause conflicts with each other, despite the fact that each works perfectly in isolation, 
and all meet the PCI specifications. Problems of this type can cause seemingly random 
system crashes. 
Â Check if the problem persists after removing the PCI card. Try to work on the 

machine, using the built-in audio hardware, for several hours without the PCI card—
if the problems disappear, you’ve found the culprit. If the problems persist, however, 
you can safely rule out PCI issues as the cause.

Â Try to use the PCI card in another slot, if available. It is often possible to resolve 
conflicts by simply swapping slots.

Faulty Cables
Cable faults are a common problem, which can cause all manner of problems.

If the computer does not respond to certain commands, the reason may be an 
intermittent USB cable fault between the keyboard and the computer. Try connecting 
the mouse directly to a free USB port. If the computer behaves normally, you will need 
to purchase a new USB cable. In some situations, you may need to replace your 
Macintosh keyboard.

Use of the correct monitor cable is important—simply having an appropriate 
connector at either end is not always sufficient. Before assuming that this is an 
unrelated hardware fault, please test the cable by swapping it with a new one.
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Another common problem is loose internal computer connections, which commonly 
occur after transporting the computer. Keeping the possible consequences to your 
warranty in mind, as well as all safety precautions, you may wish to refasten the internal 
connectors, with care. Be careful though:  disconnect the power cable first, and wait for 
the high voltage to drop. Ground yourself to the computer with an anti-static strap, or 
by touching the metal components of the case. This can prevent visits to the repair 
man (or the hospital). 

Viruses
Regrettably, there are some malicious people who program and distribute viruses, 
solely to cause damage. Check your drives regularly for viruses, especially if you 
download data from the Internet. Not all virus programs are able to detect macro 
viruses, and others which are, as yet unknown, to virus protection software developers.

Re-installing or Updating the Operating System
It is possible that as a result of a crash, or installation error, the operating system will 
become unusable. If this happens, re-install the operating system from your system 
CD-ROM.

To do so, restart your computer using the Mac OS X Installation CD (insert the CD and 
select it as the start volume in the corresponding control panel; or on newer Macs, 
simply press Command during the restart) and re-install the operating system.

Sometimes, the problems simply come down to the operating system. You can usually 
find updates for your operating system online, where they can be downloaded free of 
charge.

Formatting the Hard Disk
Formatting the hard disk is the absolute last resort you should attempt, before sending 
the computer for repair. This will erase all files on your hard disk, and any garbage data 
that may be causing your problems.

The formatting process will erase all files, so make backups of all files and programs 
first—and verify these backups—to ensure that they have been successful. Be sure to 
run virus checking software on all backups, to avoid re-infecting your newly formatted 
drive. 

To format the internal hard drive, you will need to start your computer from another 
drive, either from the CD-ROM, a flash drive, or an external hard disk. To completely 
rule out a virus problem, you should reformat all hard drives in the same session—a 
CD-ROM cannot be infected with a virus (unless it was infected to begin with). 

Important:  Please keep in mind that invisible software authorizations cannot be 
copied—please de-authorize such applications from your hard drive before erasing it!
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Reinstall Logic after installing the operating system. If the problem still persists, a 
hardware conflict, or conflict between the program and the operating system is the 
most likely situation. If the problem only occurs with a specific program, you will need 
to get in touch with the software manufacturer. If the problem lies with Logic, 
please contact AppleCare. AppleCare Support can be reached online at 
http://www.apple.com/support/logic.

If the problem occurs with several applications, you will need to get in touch with your 
computer dealer.

http://www.apple.com/support/logic
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AD converter or ADC  Short for analog to digital converter; a device that converts an 
analog signal to a digital signal.

AIFF  Abbreviation for Audio Interchange File Format. A cross-platform file format 
supported by a large number of digital audio and video editing applications. AIFF 
audio can use a variety of bit depths, most commonly 16 and 24 bit. 

alias  A pointer to a MIDI region in the Arrange area. An alias does not contain any 
data. It simply points to the data of the original MIDI region. You can create an alias by 
Shift-Option-dragging the original MIDI region to a new location. An alias can not be 
edited directly. Any change to the original region will be reflected in the alias. 

aliasing  A digital artefact that occurs when the sample material contains frequencies 
higher than one-half of the sample rate. 

amplifier  Device which increases the level of a signal.

analog signal  A description of data that consists of an endlessly varying voltage level, 
that represents audio information. Analog signals must be digitized, or captured, for 
use in Logic. Compare with digital.

anchor point  The start point of the audio file that an audio region is based on. Also 
see Sample Editor.

Apple Loops  An audio file format, commonly used for recurring rhythmic musical 
elements or elements suitable for repetition. Apple Loops contain tags and transients 
that are used by Logic for time stretching and pitch shifting tasks. These tags also allow 
you to quickly locate files by instrument, genre, or mood in the Loop Browser.

Apple Loops Utility  The Apple Loops Utility allows you to create your own Apple 
Loops. To use the Apple Loops Utility, select an audio region in the Arrange and choose 
Audio > Open in Apple Loops Utility. 

Arrange area  The primary working space of Logic. It is used to record, edit, move, and 
arrange the audio and MIDI regions of a project. Also used for automation recording 
and playback.
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Arrange window  The primary working window of the application. It also shows the 
Arrange area (see above), and can incorporate all other working areas and editors. 

Audio Bin  Window (or tab in the Media area of the Arrange window) used for project 
audio file and region management, and conversion, tasks. See Media area.

audio file  Any digital recording of sound, stored on your hard drive. You can store 
audio files in the AIFF, WAV, Sound Designer II (SDII), and CAF formats in Logic. All 
recorded and bounced WAV files are in Broadcast Wave format.

audio interface  Device used to get sound into and out of your computer. An audio 
interface converts digital audio data, sent from your computer, into analog signals that 
speakers can broadcast. In the other direction, an audio interface converts analog 
signals (such as a vocal performance) into digital audio data that can be understood by 
your computer.

Audio MIDI Setup (AMS)  The Audio MIDI Setup (AMS) utility is used to configure the 
audio and MIDI input and output devices connected to your computer. Logic uses the 
settings defined in the Audio MIDI Setup utility, which can be found in the 
Applications/Utilities folder. 

audio region  Chosen area of an audio file which can be placed on audio tracks in the 
Arrange, just like a MIDI region can be placed on MIDI tracks. Audio regions are aliases 
(or pointers) to portions of audio files. They can be as short as a single sample, or the 
full length of the underlying audio file. Logic allows you to edit audio regions without 
affecting the original audio file. Also see region and MIDI region.

audio track  A track in the Arrange window that is used for playback, recording, and 
editing of audio regions. It is routed to an audio channel in the Mixer.

audio channel strip  Channel strip in the Mixer, used as a target for audio tracks in the 
Arrange. All data on the audio track is automatically routed to the audio channel strip 
that was assigned in the Arrange track list.

Audio Units (AU)  Audio Units is the standard Mac OS X format for real time plug-ins. It 
can be used for audio effects, software instruments, and Generators. The Audio Unit 
format is incorporated into the operating system, and installed Audio Unit plug-ins can 
be simultaneously accessed by all applicable programs. Logic supports all Audio Unit 
format plug-ins.

Autopunch function  Autopunch refers to an automatic entry and exit of record mode 
at predefined positions. Autopunch mode is most commonly used to re-record a badly 
played section of an otherwise flawless recording. The advantage is that you can 
concentrate on playing, not the mechanics of driving Logic. Autopunch is activated by 
clicking the Autopunch button in the Transport bar. 
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automation  Automation is the ability to record, edit, and play back the movements of 
all knobs, controls, and buttons, including:  volume faders, pan, EQ, and aux send 
controls, plus most effect and instrument plug-in parameters.

aux channel (strip)  Aux channels are found in the Mixer (and to the left of the Arrange 
window), and can be used as send/returns (buses) and sub-group controls. 

Balance control  Rotary knob directly above the Level fader of stereo channels. It 
controls the relative level of the left and right signals at their outputs.

bar  In musical notation, a bar is a measure that contains a specified number of beats, 
and establishes the rhythmic structure of a musical piece.

Bar ruler  Ruler found at the top of the Arrange, Piano Roll, Hyper Editor and Score 
Editor windows. It displays musical time units, including:  bars, measures, beats, and 
beat divisions. It is used to set and display the project position, the cycle and 
autopunch locators. Also see playhead, Cycle, and Autopunch.

bass  A musical instrument. The term also refers to low frequency sounds or 
components within a sound. See frequency.

beat  A musical time interval:  “The beat is the regular rhythmic pulse in a composition 
that people tap their feet to.” Usually a quarter note.

beats per minute  See bpm.

bit depth  The number of bits used by a digital recording or digital device. The number 
of bits in each sample determines the (theoretical) maximum dynamic range of the 
audio data, regardless of sample rate. 

bit rate  Bit rate, when talking about MP3 files, refers to the transfer bit rate at which 
the files are encoded. Conversationally, the term is more often used to describe the 
relative quality of the file, with lower bit rates resulting in less defined audio.

bit resolution  Alternative term for bit depth. See bit depth and sample rate entries.

bounce  To process MIDI or audio regions with any applied effects, such as delay or 
compression, and combining them into one audio file. In Logic, you can choose 
between real time and offline bouncing. Offline bouncing is faster, but doesn’t allow 
you to apply live automation or record real time audio input. 

Bounce button  You can bounce the output of any output channel to an audio file by 
clicking the Bounce button. Also see bounce.

bpm  Abbreviation for beats per minute, a measure of the tempo of musical piece. As 
an example:  120 bpm means that in one minute, there will be 120 musical beats 
(quarter notes).
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Broadcast Wave  See Wave.

Browser  A Logic window (or tab in the Media area of the Arrange window) used to 
browse, select, and manage all media types supported by Logic. Also see Media area.

bus  Busses are used to send audio to aux channel strips for processing or submixing 
tasks. 

bus channel strip  The bus channel type is primarily included for backwards 
compatibility with older Logic versions. The bus channel strip functions of earlier 
versions are performed with aux channel strips in Logic.

bypass  To deactivate a plug-in. Bypassed plug-ins do not drain system resources. In 
Logic you can bypass a plug-in by either clicking its Bypass button in the plug-in 
window or by Option-clicking on the appropriate plug-in slot of a channel strip.

Caps Lock Keyboard  Logic function that allows the use of the computer keyboard as a 
real time MIDI keyboard. It is primarily intended for use while travelling with a portable 
Macintosh.

CD Audio  Short for Compact Disc—Audio; a standard for stereo music CDs:  44.1 kHz 
sampling rate and 16 bit depth.

channel strip  A channel strip is a virtual representation of a channel strip on a mixing 
console. Each channel strip contains a number of similar controls, which can include 
some or all of the following:  a Mute button, Level fader, Pan/Balance control, Input slot, 
Output slot, Send slots, Insert slots, Format button. The channel strips shown to the left 
of the Arrange window, and in the Mixer window, are used to process audio or MIDI 
information that is routed from Arrange tracks. 

channel strip setting  Logic allows the routing of a channel strip, including all inserted 
effects or instruments (plus their settings) to be saved and recalled. This simplifies the 
task of recreating complex serial effect routings between channels or projects.

checkbox  A small box. You click a checkbox to select or deselect (or turn on/off ) an 
option.

click  Metronome, or metronome sound.

Clipboard  The Clipboard is an invisible area of memory, into which you cut or copy 
selected data, using the Edit menu. Data stored in the Clipboard can be pasted to 
different positions. In Logic, the Clipboard can be used to exchange data within a 
single project or between projects.

cloned audio region  A cloned audio region is a pointer to the original region. 
Whenever you adjust the start or end points of any of these cloned regions, all other 
cloned regions will also be adjusted in the same way. 
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comping  A process where multiple recording takes are compiled into a single perfect 
take (see takes).

controller  MIDI data type. As examples:  sliders, pedals, or standard parameters like 
volume and panning. The type of command is encoded in the first data byte, the value 
being sent or received is encoded in the second data byte.

Core Audio  Standardized audio driver system for all Macintosh computers running 
Mac OS X version 10.2 or higher. Core Audio is an integral part of Mac OS X, allowing 
access to all audio interfaces that are Core Audio compatible. Logic is compatible with 
any audio hardware that offers Core Audio drivers/support.

Core MIDI  Standardized MIDI driver system for all Macintosh computers running 
Mac OS X version 10.2 or higher. Core MIDI is an integral part of Mac OS X, allowing the 
connection of all MIDI devices that are Core MIDI compatible. Logic is compatible with 
any MIDI hardware that offers Core Audio drivers/support.

count-in  Beats heard prior to the start of a recording (or playback).

Cycle function  A function in Logic which constantly repeats the area between the 
locator positions. To turn on Cycle mode, click the Cycle button in the Transport. The 
Cycle function is useful for composing a part of a project or editing events, as 
examples. The cycle area is shown as a green stripe in the top part of the Bar ruler. 

DA converter or DAC  Short for digital/analog converter; a device that changes an 
analog signal into a digital signal.

DAW  Acronym for Digital Audio Workstation. A computer used for recording, mixing, 
and producing audio files.

dB  Abbreviation for decibels, a unit of measurement that describes the relationships of 
voltage levels, intensity, or power, particularly in audio systems.

default  The preset parameter value.

destructive  Destructive audio processing means that the actual data of an audio file is 
changed, as opposed to just editing peripheral or playback parameters.

dialog  A window containing a query or message. You must interact with it (by pressing 
a button) before you can continue.

digital  A description of data that is stored or transmitted as a sequence of ones and 
zeros. Most commonly, refers to binary data represented by electronic or 
electromagnetic signals. All files used in Logic are digital. Also see analog for 
comparison.

disclosure triangle  A small triangle you click to show or hide details in the user 
interface.
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division value  Adjustable value (shown in notes) for the grid used in displays and 
operations. Third number displayed in the Transport bar’s Position display. The division 
value is set in the Transport bar, below the time signature. 

Drag menu  A pop-up menu found in the local menu of linear editing windows. It 
determines the behavior of regions or events when dragged to an overlapping 
position.

drag & drop  Grabbing objects with the mouse, moving them, and releasing the mouse 
button.

driver  Drivers are software programs that enable various pieces of hardware and 
software to be recognized by computer applications. If the proper driver is not 
correctly installed for your audio hardware, your computer may not recognize or work 
properly with it. 

editor  Window for editing MIDI or audio data. Logic offers the Hyper, Piano Roll, Event 
List, and Score editors for MIDI event data, and the Sample Editor for audio data. The 
Event List can also be used for region editing and positioning tasks.

effect  A type of software algorithm that alters the sound of an audio signal in a variety 
of ways. Logic includes a set of EQ, dynamics, time-based, modulation, and distortion 
effects in the Logic native and Audio Unit plug-in formats.

EQ  Shortened form of equalizer. Equalizers are used to boost or cut frequencies in an 
audio signal. There are several types of EQ available in Logic. 

Eraser  A tool used for deleting items. Click a selected item to delete it. All other 
currently selected items are also deleted.

event  Individual MIDI command, such as a note on command. Continuous controller 
movements (modulation wheel, for example) produce a quick succession of individual 
events—each with an absolute value. 

Event List  A list that shows all events or regions in a project. It allows you to directly 
manipulate events and regions in a precise, numerical way. It also allows you to add 
different types of events. 

export  To create a version of a file, such as a Logic project, in a different format that 
can be distributed and used by other applications.

filter buttons  Buttons in the Event List and Mixer, that allow you to hide or show 
specific event types or channel strip types.

Find field  In many Logic windows you find a field with rounded corners and a 
magnifying glass to the left. This field allows you to perform text searches. As examples, 
the Find fields in the Key Commands window or Loop Browser.
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Finger tool  Tool (as used in the Piano Roll Editor, for example) that looks like a hand 
with an extended index finger. This tool allows you to manipulate the length of events 
or perform other operations in other areas of the program. 

FireWire  Apple trademarked name for the IEEE 1394 standard. A fast and versatile serial 
interface, often used to connect audio interfaces, and audio processing units to 
computers. FireWire is well suited to applications that move large amounts of data, and 
can be used to connect hard disks, scanners, and other kinds of computer peripherals. 
There are two versions of FireWire:  FireWire 400 and FireWire 800. The latter is a faster 
variant, which uses a different connector type. Use of FireWire 400 devices on a 
FireWire 800 port is possible with suitable cabling, but it effectively halves the 
bandwidth to all devices on the port.

folder  A folder is a container for regions in the Arrange. It can contain other folders or 
regions, much like a folder in the Finder can contain other folders or files. You can 
imagine a folder as a project within a project. The inside of a folder looks just like the 
Arrange area and track list in a project. 

frequency  The number of times a sound signal vibrates each second, measured in 
cycles per second, or Hertz (Hz). 

Glue tool  This tool can be used to merge regions or events by simply clicking on two 
(or more) of them. 

grab (an object)  Positioning the mouse cursor over an object, then pressing and 
holding the mouse button down.

grid  The Logic grid is represented by vertical lines that are used to indicate the 
positions of measures, beats, and sub-beats in various editors. 

help tag  A small text window which appears when the mouse cursor is placed over an 
interface element. It indicates the name or value of the element. When editing 
operations such as moving or cutting a region are performed, a larger help tag will 
display the current (and starting) position of the region or function—in real time.

Hyper Editor  Graphical editor that can be used to create or edit MIDI note and 
controller data. The Hyper Editor is ideal for drawing drum parts and creating crescendi, 
amongst other tasks.

icon  Small graphic symbol. In Logic, an icon may be assigned to each track.

importing  The process of bringing files of various types into a Logic project. Imported 
files can be created in another application, captured from another device, or taken 
from another Logic project.
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input monitoring  This function allows you to hear incoming audio, when audio tracks 
are playing, record-enabled, or recording. Simply click the Input Monitoring button on 
Arrange audio tracks to enable or disable input monitoring.

Insert slot  A panel on Logic channel strips where you can patch in (insert) an effect 
plug-in.

Inspector  Area at the left edge of the Arrange and editors, containing the Parameter 
boxes and channel strips (Arrange) of the selected track. Also see Parameter boxes. The 
Inspector area updates to reflect the parameters relevant to the window with key focus.

instrument channel  Logic supports the use of software based instruments. Software 
instrument plug-ins are inserted into the Instrument slot of instrument channels. 
Software instrument recording takes place on instrument tracks in the Arrange. 
Playback of these tracks is routed via the instrument channel shown in the Mixer (or to 
the left of the Arrange window).

interface  1) A hardware component such as a MIDI or audio device that allows Logic 
to interface (connect) with the outside world. You need an audio or MIDI interface to 
get sound or MIDI into and out of your computer. Also see audio interface. 2) A term 
that is used to describe graphical elements within Logic that you can interact with. An 
example would be the Arrange, where graphical interface elements such as regions are 
interacted with to create a project, within the overall Logic interface.

key  The scale used in a piece of music, centered around a specific pitch. The specified 
pitch is called the root of the key. Can also refer to a black or white key on a musical 
(MIDI) keyboard.

key command  Function which can be executed by pressing a specific key (or key 
combination) on your computer keyboard or MIDI controller.

Key Commands window  The Key Commands window is used for the assignment of 
key commands to computer keys or to MIDI messages. 

key focus  The selected, active window, is said to have key focus in Logic. Many key 
commands will only function when a window has key focus. The Inspector also updates 
to reflect the parameters of a window with key focus.

latency  You may notice a delay between playing your keyboard and hearing the 
sound. This is a form of latency. A variety of factors contribute to latency, including the 
audio interface in use, audio and MIDI drivers. One factor under your control, however, 
is the I/O buffer size, which is set in the Devices preferences. 

level meter   A meter that monitors audio input or output levels to or from your 
computer. You use the level meters in Logic when recording, arranging, and editing 
audio files, and when creating a mix. 
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Library  Window (or tab in the Media area of the Arrange window) used to handle all 
settings files for channel strips, effects, and instruments. 

Link button  Button in the top left corner of most Logic windows that features the 
chain link icon. It controls the linking between different windows.

Lists area  Area in the Arrange window, providing four independent tabs that show a 
listing of the following types of data:  events, regions, markers, tempo changes, and 
time/key signatures.

local menu bar   Menu in a window that only contains functions that are relevant to 
that particular window.

locators  Lower two sets of numbers, displayed to the right of the position indicators in 
the Transport bar. The number on top is the left locator; the number below is the right 
locator. The left and right locators define the cycle time-range, useful for cycle or skip 
playback operations and cycle recording. The locators are also used to define the 
editing area for certain functions.

loop  An audio file that contains recurring rhythmic musical elements, or elements 
suitable for repetition. Logic supports Apple Loops, amongst other file formats. 

Loop Browser  Window (or tab in the Media area of the Arrange window) used to 
access and manage Apple Loop and ReCycle files.

Loop function  The Loop region parameter Logic creates loop repeats for an audio or 
MIDI region. These repetitions will continue until the project end point is reached, or 
another region or folder (whichever comes first) is encountered on the same track in 
the Arrange area. 

main menu bar  The bar at the top of the screen, offering global functions such as 
opening, saving, exporting, or importing projects. It does not offer access to local 
window functions. It does, however, contain an Edit menu—with commands that apply 
to the window with key focus.

marker  A marker is an indicator, or bookmark, that is tied to a specific time position in 
a project. It can contain text which act as notes for different versions of a project, for 
example. Markers can also be used for a number of selection and navigation tasks.

master channel strip  Channel strip in the Mixer that acts as a separate attenuator 
stage, changing the gain of all output channel strips without affecting the level 
relationships between them.

Media area  Area shown at the right-hand side of the Arrange window when the Media 
button is clicked in the Arrange Toolbar. Contains the Bin, Loops, Library, and Browser 
tabs, providing access to all media types supported by Logic.
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merge  Mix, or combine, two or more MIDI events or regions into a single event or 
region.

metadata  Metadata is additional descriptive information that is stored in the file 
header of a number of file types (Apple Loops, for example). It is used to reference 
external media, to simplify searches, and more.

metronome  A device that produces a sound that taps out the beat. In Logic, it can 
configured in the Metronome project settings.

MIDI  Abbreviation for Musical Instrument Digital Interface. Standardized, 
asynchronous, serial, event-oriented hardware and software interface for electronic 
musical instruments. MIDI is an industry standard that allows devices such as 
synthesizers and computers to communicate with each other. It controls the pitch, 
length, and volume of a musical note event, among other characteristics.

MIDI channel  A MIDI channel is a “tube” for MIDI data, which flows through MIDI ports. 
Up to 16 separate MIDI channels can pass through a port simultaneously. Tracks 
recorded in Logic can be directed to different tubes (channels), which can contain 
different information, and play back through different sounds, assigned to each 
channel. As examples, channel 1:  piano, channel 2:  bass, channel 3:  strings, and so on. 
This presumes that the receiving devices are capable of receiving data on more than 
one channel, and that they are capable of playing back different sounds 
simultaneously.

MIDI message  A message transmitted via MIDI that consists of one status byte and 
none, one, two, or many data bytes (with system exclusive commands). See event.

MIDI region  Data container for MIDI events, shown in the Arrange as a named 
horizontal beam. 

mixdown  A term commonly used to describe either bouncing (see bounce) or 
merging of tracks (see merge).

Mixer  The Mixer window displays all (or the desired) track, instrument, and MIDI 
channel strips. These channels allow you to control all aspects of track output and 
processing, including level, panning, effect and instrument processing, routing, and 
more.

mixing  The process of shaping the overall sound of a project by adjusting the volume 
levels, pan positions, adding EQ and other effects, and using automation to 
dynamically alter these and other aspects.

modifier key  Computer keyboard keys used in conjunction with alphabetical keys to 
change functionality. Modifier keys include Control, Shift, Option, and Command.

modulation wheel  A MIDI controller found on most MIDI keyboards.
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mono  Short for monophonic sound reproduction. The process of mixing audio 
channels into a single track, using equal amounts of the left and right audio channel 
signals. Compare with stereo.

movie  See video.

MP3  Abbreviation for MPEG-2 Audio Layer 3. A compressed audio file format, 
frequently used to distribute audio files over the Internet. 

mute  Switch off the audio output of a channel or track. You can mute a track or 
channel by clicking the Mute button in the track list or at the bottom of the channel 
strip).

Mute tool  This tool allows you to stop a region or events from playing, by clicking on it 
or them. 

native  Native refers to host-based processing of effects and software instruments in 
Logic. The computer CPU natively calculates the effects and instruments. Native also 
refers to the internal Logic plug-in format, which differs from the Audio Unit format. 
Logic native plug-ins only work in Logic.

nodes  Positions in Hyper Draw and automation tracks that mark the beginning or end 
of data manipulation. Occasionally referred to as (automation) points.

normalize  This function applies the current Parameter box settings to the selected 
MIDI events (by altering the actual events themselves), and clears existing parameter 
settings. When it comes to audio, a different Normalize function raises the volume of a 
recorded audio file to the maximum digital level, without altering the dynamic content.

note number  Pitch of a MIDI note, controlled by the first data byte of a MIDI note 
event.

option  Alternative function, often in the form of a checkbox, sometimes also available 
as a menu entry. 

Option  Modifier key, also known as the Alt key in MS Windows.

output channel strip  Channel strip type in the Mixer that controls the output level and 
pan/balance for each physical output of your audio interface. 

pan, pan position  The placement of mono audio signals in the stereo field, by setting 
different levels on both sides (see Balance).

Pan control  Rotary knob (directly above the Level fader) on mono channel strips, that 
determines the position of the signal in the stereo image.
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Parameter box  Field on the left side of Logic windows (or in the Inspector). It is used 
to adjust the parameters of the selected track, regions, events, or objects. Also see 
Inspector.

Pencil tool  Tool used to create empty MIDI regions in the Arrange. It can also be used 
to add audio regions to the Arrange, when used in conjunction with the Shift key. In 
the Sample Editor, the Pencil can be used to draw out transient signal spikes (pops and 
clicks) in signals. 

Piano Roll Editor  A MIDI event editor that displays note events as horizontal beams. 
Events can be cut, copied, moved, and resized in a similar fashion to regions in the 
Arrange. 

pitch  The perceived frequency of a musical sound. Corresponds to the frequency of 
the sound wave.

playback  Playing an audio or MIDI region, an audio file, or an entire arrangement, 
allowing you to hear it.

playhead  The playhead is a vertical white line which indicates the current playback 
position in all horizontal, time-based Logic windows (the Arrange, for example). The 
playhead can be directly grabbed and moved with the mouse.

plug-in  Software application that enhances the functionality of the main program (in 
this case, Logic). Logic plug-ins are typically software instruments or effects.

plug-in window  A window that opens when a plug-in is inserted, or the Insert/
Instrument slot is double-clicked. Allows you to interact with the plug-in parameters.

Pointer tool  Tool used to select or edit regions, events, menu or interface items, and 
more in Logic.

Preferences window  A window that is accessed via the Logic > Preferences menu. All 
Logic preferences can be set in this window.

preset  Set of plug-in parameter values that can be loaded, saved, copied, or pasted via 
the Settings menu in the plug-in window header. See setting and Settings menu. 

project  The Logic “song” document, that contains pointers to audio files and regions, 
plus actual MIDI data (in MIDI regions). Further settings and preferences are also stored 
with the project document.

project folder  In Logic, the top-level folder that can contain all media associated with 
a project, including audio files, sampler instruments and samples, video, and other 
data.
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project settings  The project settings are a collection of program settings that are 
specific to the current project. These are different to the global preferences that affect 
all Logic projects (see Preferences window).

protected track  A protected track cannot have its contents moved or changed.

punch in, punch out  Going into and out of record to replace a section of an existing 
recording. This process can be automated in Logic. Also see Autopunch.

quantization  Time-correction of note positions by moving them to the nearest point 
on a selectable grid (this is chosen in the Quantization menu). When quantization is 
applied to any selected event or region, Logic will move all note events to align 
perfectly with the nearest grid position. Logic quantization is a non-destructive 
playback operation, allowing different quantize values to be auditioned while listening 
to your music.

Quantization menu  Menu found throughout Logic that determines the current 
quantization grid. See entries below. 

Quantize button  Button labeled with a Q. Performs the quantize operation (chosen in 
the Quantization menu) on selected events. Also see Quantize tool and quantization. 

Quantize tool  Tool labeled with a Q. It is used to apply quantization to specific 
(selected) events, using the quantize value specified in the Quantization menu of the 
Piano Roll or Event List editors.

QuickTime  QuickTime is an Apple cross-platform standard for digitized, data-
compressed video playback and encoding. QuickTime movies can be run in a Logic 
window or on a global Video track, in sync with the project. Whenever you move the 
playhead, the film follows and vice versa. 

RAM  Abbreviation for random-access memory. Computer memory capacity, measured 
in megabytes (MB), determines the amount of data the computer can process and 
temporarily store at any given moment.

real-time effects  Effects that can be applied to regions in real time, during playback. 
Real-time effects can be used on any Macintosh computer qualified to run Logic. 

recording  The act of capturing a performance as audio or MIDI data into Logic. The 
term is also commonly used when referring to the actual data (in Logic, this is 
delineated by use of the words region or file to clarify things when discussing 
recordings).

record-enable  Audio tracks musty be manually armed (record-enabled) before you can 
record on them. MIDI tracks are automatically record-enabled when selected. Software 
instrument tracks are automatically “pre-armed,” and must receive a MIDI message to 
be record-enabled.
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region  Regions are found on Arrange tracks:  They are rectangular beams that act as 
containers for audio or MIDI data. There are three different types of regions:  audio 
regions, MIDI regions, and folder regions (usually referred to as folders). Also see:  audio 
region, MIDI region, and folder.

Region Parameter box  Box in the upper part of the Arrange Inspector, used to non-
destructively set the playback parameters for individual regions, including quantization, 
transposition, velocity, compression, and delay. These parameters do not alter the 
stored data. Rather, they affect how the events are played back. 

routing  Generally refers to the way audio is sent through processing units. Also often 
used to describe specific input and output assignments.

rubber band selection  Technique for selecting consecutive regions, objects, or events 
by click-holding and dragging the mouse cursor around the desired items. A rubber 
band selection envelope (an outline) will expand from the starting position of the 
mouse cursor. All objects touched or enclosed by the rubber band selection envelope 
will be selected.

sample  A digital recording of a sound at a particular instant in time.

Sample Editor  The Logic Sample Editor allows audio files to be destructively cut, 
reversed, shortened, changed in gain, and processed in a number of other ways. It 
allows editing of individual samples within an audio file consisting of thousands, or 
millions, of samples. The Sample Editor also provides access to a number of special 
sample processing tools, collectively known as the Digital Factory. 

sampler  Device used for sampling. In Logic, this generally refers to the EXS24 mkII 
software-based sampler.

sample rate  When an analog audio signal is converted to a digital signal, this term 
refers to the number of times per second the audio file is sampled. Logic can record 
and edit audio at sample rates ranging from 44.1 kHz (44,100 times per second) up to 
192 kHz (192,000 times per second). 

sample rate converter  Device or algorithm that translates one sample rate to another. 

sampling  The process of converting analog audio into digital information. The sample 
rate of an audio stream specifies the number of samples that are captured per second 
(see sample rate). Higher sample rates yield higher quality audio. 

scale  A group of related musical notes (or pitches) that forms the basis of the melody 
and harmony in a piece of music. The most common scales are the major scale and 
minor scale.
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Score Editor  Logic editor that deals with standard musical notation. MIDI note events 
are represented as quavers, crotchets, minims, and so on. The Score Editor allows you to 
adjust and edit the layout of the score, and print it.

screenset  A layout of various windows, inclusive of all display parameters (zoom, 
position, size of each window, and so on) is called a screenset. You can swap between 
different screensets, much as you might swap between different computer monitors. 

scroll bar and scroller  Gray beam at the edge of a window. A movable box inside the 
beam is used to select the displayed project section in the window.

semitone  Smallest interval between two pitches in the standard diatonic scale, equal 
to a half tone. A semitone is also called a half step or half tone. 

send  Abbreviation for auxiliary sends. An output on an audio device used for routing a 
controlled amount of the signal to another device. Sends are often used to send several 
signals to the same effect, which is useful for computationally-intensive effects such as 
reverb.

Send slot  A panel shown on mixer channel strips that enables you to send (via a bus) a 
portion (or all) of the audio signal to an auxiliary channel strip. You may use multiple 
sends on channels.

sequencer  The term sequencer is generally used to describe a computer application 
that allows you to record both digital audio and MIDI data, and blend the sounds 
together in a software mixing console. In earlier times, a sequencer was a hardware 
device that controlled synthesizers via a series of control voltages and gates, or via MIDI 
only. No audio recording or control was available.

setting  1) A parameter value. 2) A set of plug-in parameter values that can be loaded, 
saved, copied, or pasted via the Settings menu. A plug-in setting is also known as a 
preset. Also see preset and Settings menu.

Settings menu  Found in the gray header at the top of all plug-in windows. Allows you 
to save, load, copy, and paste settings:  the parameter values of effects and software 
instruments.

SMPTE ruler  In addition to the standard bar/beat display, the Logic Bar ruler can 
display time units in SMPTE format:  hours, minutes, seconds, and frames, and can 
display time code if a video is imported into the project.

Snap menu  A pop-up menu found in the local menu of linear editing windows. It 
determines the behavior of regions or events when edited; lengths and cuts will snap 
to the nearest possible position (as determined by the chosen Snap menu value), for 
example.



104 Glossary

 

software instrument  Software counterpart to hardware samplers or synthesizer 
modules, or acoustic sound sources such as drum kits or guitars. The sounds generated 
by software instruments are calculated by the computer CPU, and played via the audio 
interface outputs. Often colloquially called softsynths or softsamplers.

solo  A way to temporarily highlight one or more tracks or regions or events, allowing 
them to be heard in isolation. 

Solo tool  Click-holding on individual regions or events with the Solo tool temporarily 
allows them to be heard in isolation. All other objects are muted.

stereo  Short for stereophonic sound reproduction of two different audio channels. 
Compare with mono.

Sync button  This button, found on the Transport bar, activates/deactivates external 
synchronization mode.

synthesizer  A device (hardware or software) that is used to generate sounds. The word 
is derived from early attempts with mechanical and electronic machines to emulate (or 
synthesize) the sounds of musical instruments, voices, birdsong, and so on. Logic 
features several software synthesizers, including the ES1, ES2, EFM 1, ES E, ES P, and 
ES M.

takes  A take, put simply, is a recording. Logic allows you to create several takes, one 
after the other, without leaving record mode. These takes can then be compiled into a 
super take (see comping). 

template  A project that contains settings and preferences that you have defined. 
Templates serve as a starting point for new projects (scoring tasks, audio only projects, 
MIDI only projects, and so on, as your personal needs require). Any project can be used 
as a template, and you can create and save multiple templates.

tempo  The playback speed of a piece of music, measured in beats per minute. Logic 
allows you to create and edit tempo changes in the Tempo track.

timing  Measure of the ability to play notes at the right time. Timing can also refer to 
synchronization between events, regions, and devices.

Toolbar  The top of the Arrange window features the Toolbar, which is used to access 
or hide certain onscreen areas, such as the Media or Lists area or Inspector. It also 
contains a number of buttons for key functions, such as Locking/Unlocking SMPTE 
positions. You may freely customize the Toolbar to meet your needs.

Tool menu  Available in the local menu bar of a window, containing tools for editing, 
zooming, cropping, and otherwise manipulating items in the window. 
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track  A horizontal row in the Arrange that contains either audio or MIDI regions that 
can be played back over time. Each track has a specified destination (a channel strip) 
that data is routed to. Logic allows hundreds of tracks to be used in a project.

track arming  See record enable.

track list  Situated to the left of the Arrange. Displays the channel strips assigned to 
various tracks as well as Track Solo, Mute, and other buttons. 

Track Protect button  The button featuring the lock icon, shown in the Arrange track 
list:  allows/disallows further edits to tracks. Also see protected track. 

Transport bar  A field shown at the bottom of the Arrange window, used to control 
recording and playback functions. The Transport bar offers Record, Pause, Play, Stop, 
and Rewind/Forward buttons plus other functions. You can also open independent 
Transport bar windows by choosing Window > Transport (Command-7).

transposition  Transposition is the act of changing the pitch of an audio or MIDI region 
(or event) by a number of semitones. 

Undo function  Function which reverses the previous editing operation. The Undo 
History allows multiple undo steps to be made.

velocity  Force at which a MIDI note is struck; controlled by the second data byte of a 
note event.

Velocity tool  This tool, found in the Logic MIDI editors, allows the velocity of 
individual, or grouped, note events to be adjusted.

WAV, WAVE  The primary audio file format used by Windows-compatible computers. In 
Logic, all recorded and bounced WAV files are in Broadcast Wave format, which includes 
high-resolution timestamp information that stores positional information. This makes it 
easy to align these files in other audio and video applications.

waveform  A visual representation of an audio signal. Waveform graphics run from left 
to right, and are centered on a horizontal line. Louder portions of the waveform 
(amplitude peaks) are indicated as taller spikes or higher curves in the waveform.

wet/dry mix  Refers to the ratio of a signal that effects have been added to (wet), and 
the original, unprocessed signal (dry). 

zero crossing  A point in an audio file where the waveform crosses the zero amplitude 
axis. If you cut an audio file at a zero crossing there will be no click at the cut point.

zoom  An action that enlarges (zooms in on) or shrinks (zooms out from) the display in 
a Logic window. The Zoom tool, and the zoom controls found in the lower left and 
upper right corners of windows, are both used for zooming tasks. Also see zoom 
control and zoom level. 
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zoom control  The control that appears at the bottom right of some windows, such as 
the Arrange. The zoom control slider allows you to navigate through the entire length 
of the currently displayed project. The lines on the left and right of the slider can be 
clicked to zoom in and out by a fixed percentage. 

zoom level  The amount that window contents (tracks and regions, for example) are 
magnified. Zooming in to a high level allows you to make more precise edits. 
Conversely, you can zoom all the way out to see the entire project and work on very 
large sections. 

Zoom tool  This tool allows you to zoom in on any part of the active Logic window. You 
can choose this tool from the Toolbox, or activate it when using other tools by holding 
down the Control key and clicking. 
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editing  69
writing  69

Automation Parameter menu  68
auxiliary channel strip  65, 91

B
backup  82
Balance control  64–65, 91
bar, described  91
Bar ruler  19, 91
beat  91
beats per minute  91
Bin. See Audio Bin
bit depth  78, 91
bit rate  91
bit resolution. See bit depth
bouncing  70, 91
bpm. See beats per minute
Browser

adding audio file  15
adding audio file and creating track  18
described  92
displaying  15
List and Browser view  16
navigating  15
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bus (Mixer)
described  92
sending channel strip to  66

bypassing
described  92
plug-in  56, 58

C
channel strip

automating  67–69
auxiliary  65, 91
controls  64
described  92
grouping  65
in Arrange window  46
level  65
overview  53
panning  65
selecting  64
sending to bus  65
Send slot  66

channel strip setting
described  12, 92
loading  11, 57

checkbox  92
Clipboard  92
Command-click tool  34
computer, optimizing for audio applications

hard drive  81
hardware  81
memory  81
software  82

controller, described  93
control surface  73
converting audio files  61
copying

audio  77
audio file  61
audio files to project folder  8
plug-in setting  58
region  41

Copy key command  41
Core Audio  79, 93
Core MIDI  80, 93
count-in time  27
creating

audio recording  28
MIDI recording  30
MP3 file  61
note event  50
project  9
track  10

Cut key command  40
cutting, region  40
Cycle function  20–21, 93

D
DAW. See digital audio workstation
decibel  93
destructive editing  60, 93
dialog  93
digital audio  76–78, 93
digital audio workstation  93
Digital to Analog Converter  78, 93
division value  94
documentation conventions  6
driver  94

E
editor, described  94
effect

See also plug-in
bypassing  56, 58
choosing setting  57
described  94
editing parameters  58
loading  11, 55
removing  56
replacing  56
sharing  65

EQ effect  56, 94
Eraser tool  36, 42, 94
event

creating  50
described  94
editing  47–51
position  49
quantizing  51
velocity  50

Event List  49, 94
exporting

audio file as MP3  61
described  94

F
faulty cable  85
Find field  94
Finger tool  95
FireWire technology  95
folder (region)  95

G
Glue tool  95

H
hard drive  81
Hyper Editor

described  95
opening  47
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I
importing

Apple Loop (audio)  14
Apple Loop (software instrument)  16
audio file  15
described  95

Input Monitoring button  28
inserting effect. See effect, loading
Insert slot  53
Inspector  44–46, 96
instrument plug-in. See software instrument
Instrument slot  53
interface  96

K
key commands  71

Copy  41
Cut  40
described  96
Open Audio Project Settings  26
Paste  41
Play  18
Record  28
Save  11
Stop  18
View Track Automation  68

key focus  96

L
latency  96
left locator. See locator
level, adjusting of channel strip  65
Library

described  56, 97
loading channel strip settings  11, 57
loading effect settings  57
loading instrument settings  54, 57
opening  57

Link button  58, 97
Lists area  49, 97
live mode  30
loading

channel strip setting  11, 57
effect  11, 55
effect setting  57
EQ effect  56
plug-in  11
software instrument  11, 54
software instrument setting  54, 57

local menu bar  10, 97
locator  20, 97
Loop Browser  14, 97
looping

playback  20
region  43

M
Media area

described  97
displaying  9

media file, adding
Apple Loop (audio)  14
Apple Loop (software instrument)  16
audio file  15
MIDI region  16

memory  81
metronome  27, 98
MIDI  75–76, 98
MIDI editors  47–49
MIDI event. See event
MIDI recording

See also recording
correcting timing  31
creating  30
live mode  30

MIDI region
See also region
correcting timing  31
described  13, 17, 98
editing  47–51
quantizing  31

Mixer
See also channel strip
changing view  64
described  63, 98
filtering channel strip types  64
opening  63
selecting channel strip  64

mixing  63–70
modifier key  98
monitoring incoming audio  28
moving

playhead  19
region  39

MP3 file
creating  61
described  99

Mute tool  36, 99
muting

described  99
region  36
track  38

N
native processing  99
navigation  18–21
normalizing  59, 99
note event

changing velocity  50
creating  50
quantizing  51
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O
Open Audio Project Settings key command  26

P
panning a channel  65
Paste key command  41
Pencil tool  36, 100
Piano Roll Editor

creating note events  50
described  100
editing note events  50
editing velocity  50
opening  47
quantizing note events  51

pitch, described  100
playback

described  100
looping  20
position  19
starting  18, 19

playhead  19, 100
Play key command  18
plug-in

See also effect and software instrument
bypassing  56, 58
choosing setting  57
described  100
editing parameters  58
loading  11
removing  56
replacing  56

plug-in window
described  58, 100
linking  58
opening  58

Pointer tool  35, 100
preset  100
project

bouncing  70
creating  9
described  7, 100
exporting  70
navigating  18–21
returning to the beginning  18
sample rate  26
saving  8, 11
tempo  26

project assets  8
project folder  8, 100
punch in/out  101

Q
Quantize tool  101
quantizing

described  101
MIDI region  31
note event  51

QuickTime movie, described  101

R
RAM  81, 101
recording  25–31

audio. See audio recording
metronome  27
MIDI. See MIDI recording
software instrument. See MIDI recording
takes  29

Record key command  28
region

copying  41
cutting  40
deleting  42
described  13, 102
dividing  40
editing  38–43
looping  43
moving  39
muting  36
pasting  41
resizing  39
selecting  23
soloing  37
transposing  46

Region Parameter box  44, 102
resizing

editing area in Arrange window  48
region  39

right locator. See locator
routing  102
rubber band selection  23, 102

S
Sample Editor  59, 102
sample rate  26, 78, 102
sampling  102
Save key command  11
saving project  11
scale, described  102
Scissors tool  36, 40
Score Editor

described  103
opening  47



Index 111

 

screenset
described  72, 103
locking  72
more than nine screensets  72
recalling  72
setting up  72

selecting
channel strip  64
region  23
rubber band  23, 102
tool  34
track  22, 64

send effects  65
Send slot  66, 103
sequencer, described  103
setting

See also preset
choosing. See effect or software instrument
described  103

SIAL (Software Instrument Apple Loop)  17
Snap menu  103
software instrument

See also plug-in
bypassing  56, 58
choosing setting  54, 57
described  104
editing parameters  58
live mode  30
loading  11, 54
recording. See MIDI recording
removing  56
replacing  56

Software Instrument Apple Loop  17
soloing

region  37
track  38

Solo tool  37
Sound preferences (Mac OS X)  79
Stop key command  18
synthesizer, described  104

T
takes  29
templates  7, 9, 104
tempo  26, 104
timing

correcting  31
described  104

Tool menu
described  34, 104
opening at mouse pointer  35

tools
assigning to Command-click  34
assigning to right mouse button  34

default tool  35
described  34
effective range  35
Eraser  36, 42, 94
Finger tool  95
Glue tool  95
Mute tool  99
Pencil  36, 100
Pointer  35, 100
Quantize tool  101
Scissors  36, 40
selecting  34
Solo tool  37
Velocity tool  50, 105
Zoom tool  39

track
creating  10
creating when adding media file  17
muting  38
selecting  22, 64
soloing  38

track automation. See automation
track list, described  105
Track Parameter box  45
Transport bar  18, 105
transposing

described  105
region  46

troubleshooting
faulty cable  85
formatting hard disk  86
parameter-RAM  84
PCI error  85
preferences  84
re-installing operation system  86
repairing file structure  85
virus  86

U
undoing operations  21

V
velocity, described  105
Velocity tool  50, 105
View Track Automation key command  68
virus  86

Z
zero crossing, described  105
zoom control  106
zooming  39, 105
Zoom tool  39
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